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2 CHAPTER

Welcome to the The Financial Edge End of Year Guide. This guide was written to help you with your end of year
processes. The information in this guide is organized by program. The following list contains the title of each
chapter and a summary of the information you can find in each.

Warning: Information in this guide is subject to change. Please visit our website at www.blackbaud.com to
view the most current information.

Chapter 1: Welcome. This chapter is an introduction to the The Financial Edge End of Year Guide and includes
a section detailing the various Blackbaud services and solutions we offer.

Chapter 2: General Ledger End of Year. This chapter provides detailed information on General Ledger end
of year processes such as running end of year reports, closing fiscal years, summarizing fiscal years, and
purging fiscal years.

Chapter 3: Accounts Payable End of Year. This chapter provides detailed information on Accounts
Payable end of year processes such as setting up 1099 vendors, editing distribution information, adding 1099
amounts to 1099 vendors, and reporting on 1099 vendors.

Chapter 4: Student Billing End of Year. This chapter provides detailed information of Student Billing end of
year processes such as copying and editing billing items and bill codes from one school year to the next,
adding new billing items and bill codes, promoting students to the next grade, verifying and editing student
information, and posting to General Ledger.

Note: You can download the Circular E, MMREF-1, and specifications for filing various tax forms, from
WWW.irs.gov.

Chapter 5: Payroll End of Year. This chapter provides detailed information on Payroll end of year processes
such as getting ready for the first payroll of the new year and making tax adjustments.

Blackbaud Solutions and Services

This section provides an overview of the services and training solutions we offer to help you successfully install,
implement, and use The Financial Edge.

Blackbaud Forms

Blackbaud Forms provides custom checks, student bills, statements, invoices, purchase orders, tax forms,

envelopes, and other computer forms that are specifically designed for use with The Financial Edge. Blackbaud
forms are guaranteed to align correctly and can be customized to your organization’s specifications, using your
logo, special inks, and print styles. Pre-printed forms from other suppliers are not guaranteed to align properly.

For more information, you can visit the forms section of our website at http://forms.blackbaud.com or send an
e-mail with questions to forms@blackbaud.com. You can also call 866-4-BB-FORMS (866-422-3676).

Data Services

We offer a wide range of data services. From database conversion to database consolidation, our staff of
programmers and analysts have the experience, technology, and expertise to meet your organization’s needs.

To request a quote for data services or database conversion, please contact our Conversion Coordinator by e-mail
at conversionestimate@blackbaud.com or by phone at 1-800-468-8996 x4200. You can also submit your request
from the Data Services page on our website at www.blackbaud.com/services/dataservices/asp.
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Accounting System Consulting

Accounting System Consulting services help you get the most out of your Financial Edge software by aligning
your organization’s systems with its processes and objectives. We partner with you to learn about your
organization, identify issues and plan a solution that is tailored to your needs.

Our consultants offer a uniqgue combination of accounting experience and in-depth knowledge of our software.
Many of our consultants have gained experience by serving as controllers and technical specialists and have
worked for Big Five firms, nonprofit organizations, and the Financial Accounting Standards Board (FASB). They
can share insight garnered from their work with hundreds of nonprofit organizations. Our accounting consulting
team knows the software inside and out and are available to help you make the most of your system.

To learn how your organization can benefit from our Accounting System Consulting services, call 800-443-9441 or
e-mail solutions@blackbaud.com.

Technical Consulting

Let our knowledgeable consultants bring their technical expertise to your site and manage the implementation of
your Financial Edge products. By entrusting the nuts and bolts of implementation to one of our consultants, you
ensure optimal setup of your system while keeping your time and energy focused on fostering your
organization’s mission.

Whether it is software installation or a detailed assessment of your current IT capabilities and needs, our team of
Microsoft, Cisco, and Oracle certified engineers can help you meet your technical challenges head on.

If you would like to arrange for consulting services, please call our Sales Department at 1-800-443-9441. Or send
an e-mail outlining your specific needs to sales@blackbaud.com.

To learn more about our technical consulting offerings, such as technology assessments, diagnostic services and
software installations, you can download the printer-friendly document “Technical Consulting Services” from our
website.

Training Solutions

Because we understand how important training is, we offer a variety of options to meet your different needs.
Training is a vital part of realizing the full potential of your software. It not only increases efficiency, accuracy, and
saves time, but you’ll also see a boost in your staff’s job satisfaction as they become more confident and valuable
in their roles.

For information about the best training option for your organization, check out our Training page on
Blackbaud.com at https://www.blackbaud.com/nonprofit-training/, or call your account representative at
1-800-443-9441. You can also send an e-mail to solutions@blackbaud.com.

This section provides a brief description of the training solutions we offer.

Start Learning. As a Blackbaud customer, you have access to Start Learning -- a collection of free online training
videos. Use these short product lessons to help you develop and maintain the essential skills you need to
make the most out of your Blackbaud solutions. You can access Start Learning from the Training page of
Blackbaud.com.

Blackbaud Learn. Blackbaud Learn is an annual subscription that provides the ongoing skill development and
job knowledge training your staff wants and needs, including strategy and best practices, role-based
curriculum, exclusive “Q&A” sessions, and new classes every month. There is a distinct Blackbaud Learn for
each of the following Blackbaud solutions: The Raiser’s Edge, The Financial Edge, The Education Edge, and
both Internet solutions Blackbaud Net Community and Blackbaud Sphere. For more information about
Blackbaud Learn, go to the Training page of Blackbaud.com.
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Instructor-led Training. With Instructor-led training, you can interact with our instructors via interactive online
classes or regional classes at any of our more than 50 locations across the United States and Canada, including
our training facility in Charleston, SC. We offer sessions on strategy and best practices, as well as personalized
custom trainings. For more information about Instructor-led Training, go to the Training page of
Blackbaud.com.

Self-paced Training. Self-paced training gives you access to the eLearning Library -- a collection of online
lessons that take you step-by-step through key concepts and tasks in your Blackbaud products. You can
choose from hundreds of pre-recorded lessons 24 hours a day, 7 days a week and take them at your own pace.
Plus, the eLearning Library is included with any Blackbaud Learn subscription. For more information about
Self-paced Training, go to the Training page of Blackbaud.com.

Role-based Training. Whatever your role, we've designed a curriculum pathway to best meet your needs.
With Role-based training, you can take advantage of classes grouped specifically to help you in your
day-to-day job. For more information about Role-based Training, go to the Training page of Blackbaud.com.

Software Maintenance Services

Our maintenance programs supplement your software purchase by providing you with tools, resources, and
support so you can use the software at its fullest potential. To meet your organization’s needs, we have several
plans from which to choose. For information about the maintenance plans, go to
http://maintenance.blackbaud.com.

Customer Support

Our Customer Support department endeavors to provide the industry’s best customer service. Through
education and support, we focus on empowering clients to use Blackbaud software in a manner that achieves the
maximum benefit to their organizations, thereby advancing each client’s individual mission. We continually strive
to meet our commitment to “help you make the world a better place” through friendly, swift, and knowledgeable
assistance to each client upon every contact with any member of Customer Support.

Our customer support department is staffed by dedicated analysts who take seriously their mission to provide
the very best in ongoing support. Support analysts are available to assist you from 8:30 a.m. - 8:00 p.m. EST,
Monday through Friday.

Contacting Support

For the fastest response, access our website at www.blackbaud.com and create a case in “Case Central”. From
“Case Central” you can also view analysts’ notes on your organization’s cases, add notes to your open cases to
communicate with the support analyst who is assisting you, or request that we reopen a closed case. Your
organization’s cases are confidential.

If you prefer, you can send us an e-mail at afnsupport@blackbaud.com. Please include your name, your
organization’s name, site ID, and as much information as possible in your e-mail so we will be prepared to assist
you quickly. If you would like to speak with a Customer Support analyst, you can call 1-800-468-8996. You can
also contact Customer Support via fax at 1-843-216-6100.

Blackbaud Developer Network

The Blackbaud Developer Network (BDN) is an alliance of development partners, including system integrators,
consultants, CPA firms and nonprofit organizations, that work with us to create solutions that expand the
capabilities of The Financial Edge. These solutions are additional applications, created specifically for our clients,
that work with our software to expand functionality. For example, BDN solutions can include customized tools
and plug-ins that integrate or interact with The Financial Edge to help your organization accomplish more in less
time.
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Our BDN development partners have been carefully selected. They each possess a distinct understanding of our
software products and how nonprofit organizations use them to further their mission. This insight, coupled with
technical expertise, provides the basis for creating quality solutions you can use to do more.
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Closing the fiscal year with Blackbaud’s General Ledger is a two-step process. First, you should run the pre-close
report. After the report has successfully validated your data, you can close the fiscal year to complete the
process.

Please read this chapter completely before you begin the end of year process.

The end of year process is typically run a few months after the end of the current fiscal year. This allows you time
to complete your annual audit and make any adjustments your accountant may suggest.

Running the General Ledger end of year process:

¢ Automatically calculates the net/surplus deficit for each fund and transfers this amount into the appropriate
fund balance account.

¢ Calculates the fiscal year-end closing balances for all balance sheet accounts and creates an opening balance for
these accounts for the next fiscal.

¢ Sets the income statement account balances to zero.
¢ Calculates the increase/decrease in net assets and calculates the ending net asset balances for the year.
¢ Permanently restricts journal entries to the closed fiscal year.

End of Year Considerations

Becoming familiar with the following issues will help you decide when to close your fiscal year.
¢ Unlimited fiscal years can be left open in the program.
¢ Unlimited fiscal years can be defined in the program.

¢ Closing a fiscal year permanently restricts journal entries to any of the fiscal periods contained in the fiscal year
you are closing.

¢ Closing a fiscal year does not delete any transaction detail. Other options are available for summarizing and
deleting transaction detail for the fiscal year.

Note: Because transaction detail is not deleted during the end of year process, printing hard copies of your
general ledger detail for the fiscal year is not a necessity.

¢ You can “soft close” a fiscal period, which restricts journal entries to a fiscal period, but allows the period to be
re-opened later for journal entries. Running the end of year process “hard closes” all periods for the year being
closed and prevents any further posting to these periods.

¢ You can run the end of year process at any future date.

Prep Work

To ensure a smooth end of year process, we recommend the following:
¢ Post to General Ledger from all of your Blackbaud systems.

¢ In Configuration, verify a fund balance account has been defined correctly on the Funds page. Review the
closing method for each fund to ensure the fiscal year-end close will produce the desired results.

¢ In Configuration, verify your next fiscal year has been defined.

e Make sure all users have exited and signed out of The Financial Edge. If the database integrates with The
Raiser’s Edge, have all The Raiser’s Edge users exit and sign out also.

¢ Make backups of your data.
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Running an End of Year Report

Warning: Backups are essential elements in completing the end of year process. They protect your data in
case of power failures, surges, or other interruptions in processing.

Running the pre-close report automatically starts a series of checks and balances to determine the process
prerequisites have been met. If they have not, an error report is generated. You can re-run the pre-close report
until a successful report is produced. Before you can close the fiscal year, you must produce a successful report.

The pre-close report will contain the following information:

¢ Alist of each fund and project (if applicable) and the net surplus/deficit amount to be posted to the fund
balance accounts defined on the fund records.

¢ The net asset code summary, which lists the net decrease/increase for the three net asset classifications.
¢ Alist of any open current year batches.

» Running a pre-close report

1. From the Administration page in General Ledger, click Close fiscal years. The Close Fiscal Year screen

appears.
@ Close FiscalYear @]

1. General |2: Fund fiIterI

Cloging Options

Action: IF'rint pre-cloze report j
Fizzal year: |2[|DD j
Report Options

Action;  [Preview Repot x| [WeKPRINTTSDOCEK =]

Orientation: I Portrait w7 I

< Bachk | Mext » | EunNowl Cancel |

In the Action field of the Closing Options frame, select “Print pre-close report”.

In the Fiscal year field, select the fiscal year to pre-close or close.

In the Action field of the Report Options frame, select “Preview Report” or “Print Report”. If you select
“Print Report”, also select a printer.

5. In the Orientation field, select “Portrait” or “Landscape” depending on how you want the report to
appear for printing or previewing.
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6. Click Next or select the Fund filter tab. The Fund filter tab appears.

@4 Close Figcal Year

1: General 2 Fund filter I

&0 0pen B Clear All Filters

Filters | Include | Selected Filers |
Funds All <Al Funds>

< Back | Ui [ | Bun How Cancel

I
7. Inthe Include column, select “All” or “Selected”.

If you choose “Selected”, the Selected Funds screen appears for you to select the funds to close. Make
your selections and click OK. You return to the Filters tab, and the filters appear in the Selected Filters
column.

Click Run Now to generate the end of year report.

9. The report will show on the screen. Make sure you print a copy for your records by clicking Print located
on the Preview screen.

Pre-closing and Closing Fiscal Years

The purpose of closing a fiscal year is to update the net asset accounts in the balance sheet with income
statement activity. At the end of the year, General Ledger adds all income statement transactions together to
calculate the net surplus/deficit for the year. It then “zeros” income statement account balances by transferring
the net surplus or deficit to the appropriate net asset accounts. In balance sheet accounts, ending balances roll
forward to the next fiscal year.

You can also pre-close a fiscal year. A pre-closing is a mock closing used to temporarily close a year speed
reporting. Because closing a fiscal year is permanent, we encourage you to pre-close each fiscal year as soon as
you finish entering and posting all transactions for the year before running the actual closing process.

Once you close a fiscal year, information remains available for reporting until it is purged. However, you cannot
post new activity to a closed year. This section contains procedures for managing the fiscal years you define in
Configuration in General Ledger.

» Pre-closing or closing a fiscal year

Warning: Before you can close a fiscal year, you must define at least one subsequent fiscal year in the program

1. From the Administration page in General Ledger, click Close fiscal years. The Close Fiscal Year screen
appears.
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If users are currently logged into the program, a list of those users is displayed. Before you can run the

pre-closing or closing process, all users must exit the program. Once all users exit the program, the Close
Fiscal Year screen appears.

& Close Fiscal Year I

1: General |g: Fund Filterl

Cloging Options -

Action; IF'rint pre-close report j
Fiscal year; I 2000 j
Report Options

Action:  |Preview Report ¥| [w2KPRINTIWDOCEK =]

Orientation: I Portrait A I

< Bach | MNext > | BunNowl Cahcel I

Warning: Because closing a fiscal year is permanent, we encourage you to pre-close before running the actual
closing process.

2.

In the Action field of the Closing Options frame, select “Print pre-close report”, “Pre-close fiscal year”, or
“Close fiscal year”.

In the Fiscal year field, select the fiscal year to pre-close or close.

In the Action field of the Report Options frame, select “Preview Report” or “Print Report”. If you select
“Print Report”, also select a printer.

In the Orientation field, select “Portrait” or “Landscape” depending on how you want the report to
appear for printing or previewing.

Click Next or select the Fund filter tab. The Fund filter tab appears.

&% Close Fiscal Year I

1: General 2 Fund filker |

&20pen B Clear All Fiters

Filters | Inciude I Selected Filters
Funds Al <4 Funds>»

< Back | Hents | BunNowl Cancel |

In the Include column, select “All” or “Selected”.
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If you choose “Selected”, the Selected Funds screen appears. Select the funds to close and click OK. You
return to the Filters tab, and the filters appear in the Selected Filters column.

8. Click Run Now. If you selected “Pre-close fiscal year” or “Close fiscal year”, a screen appears confirming
you want to pre-close or close the fiscal year.

9. To continue pre-closing or closing the fiscal year, click Yes.

If the program detects errors during the pre-closing or closing process, you can view the End of Year Error
Report to see where problems exist. To return to the Close Fiscal Year screen, close the report. This report
prints automatically without previewing it, if you choose that report option.

Note: Once a fiscal year is successfully pre-closed or closed, the status for that year will be “Pre-Closed” or
“Closed” on the Fiscal Years page in Configuration.

If the pre-close or close process is successful, a confirmation message appears.

10. To process the end of year report, click OK. The report appears for you to preview or prints depending on
the report options you select. If you preview the report, you can return to the Close Fiscal Year screen by
closing the report. If you print the report, the program automatically returns to the Close Fiscal Year
screen.

Summarizing Fiscal Years

To save space in your database, you can use the Summarize Fiscal Years utility to summarize all transactions for
closed fiscal years. During the summarizing process, the program removes all transaction detail, including
associated distributions. The program does, however, save the beginning and ending balances, as well as the total
net change for the project, class, and transaction code distribution for each fiscal period.

Warning: Before you can summarize the fiscal year, you must close it.

Once you summarize a fiscal year, you can produce reports on the beginning and ending balances and the net
change and net asset class for each account. If you have the optional module Projects and Grants, you can also
produce reports on transaction codes and projects.

» Summarizing a closed fiscal year

1. From the Administration page in General Ledger, click Summarize fiscal years. The Summarize Fiscal Year
screen appears.

i Summarize Fiscal Year

w | Fizgcal vear 1933-2000

Summarize all fiscal years through |FEEE

[ Delete batch headers if all tranzactions within a batch are summarized

Surnmarize Mow I Cancel I

2. In the Summarize all fiscal years through field, select the closed fiscal year you want to summarize.

Warning: If you mark this option and all transactions associated with a batch fall in the fiscal years being
deleted, the program also deletes the batch header record. We recommend you run a Batch Summary Report
before deleting batch headers.

3. To delete batch headers if all transactions within a batch are summarized, mark the checkbox.
4. Click Summarize Now. A confirmation message appears.
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5. To continue, click Yes. A processing screen appears. Once the process is complete, a confirmation
message appears.

Accounting for Monprofits

k}) You have succezsfully summanzed all fizcal years up to and including 1333-2000,

6. To return to the Administration page, click OK.

Purging Fiscal Years

Warning: We strongly recommend running financial statements and creating a backup of fiscal year
information prior to purging.
By purging a fiscal year, you remove all detail about the fiscal year from your database. However, the program
does not delete any account numbers and tables used in a fiscal year. Before a fiscal year can be purged, you
must close it. Before purging a fiscal year, you should run all financial statements and save or print copies to keep
for your records. We also strongly recommend you create a backup of fiscal year information prior to purging.
You cannot recover a purged fiscal year without restoring to a backup.

Note: If you do not have security rights to purge fiscal years, you cannot see the Purge Fiscal Years link on the
Administration page.

» Purging a fiscal year
1. From the Administration page in General Ledger, click Purge fiscal years. The Purge Fiscal Year screen
appears.

& Purge Fiscal Year

Fizcal ¥ear 1993-2000

Purge all fizcal years through

Purge Mow Cancel |

In the Purge all fiscal years through field, select the closed or summarized fiscal years to purge.

Click Purge Now. A confirmation message appears.

Note: To stop purging the selected fiscal year while the processing screen is displayed, click Cancel.

4. To continue the purging process, click Yes. A processing screen appears. Once purging is complete, a
confirmation message appears.

Accounting for Honprofits

\::) Y'ou have successfully purged all fizcal years up to and including 1333-2000.

5. To return to the Administration page, click OK.
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Wrap Up

After the end of year process has finished, check the system to ensure the changes have been made to your data.
¢ View the Fiscal Year page in Configuration. Note the status for the fiscal year has changed to “closed.”
¢ Print financial reports and compare them with statements printed before running the end of year process.

Questions and Answers

Question:

I have closed the fiscal year, and now | want to clear out some of the transaction detail from the year. Does
closing the year do this?

Answer:

Closing a fiscal year removes no transaction detail from the database. Two options are available to remove excess
data from the database. The Summarize Fiscal Year option nets all transactions from a fiscal period into one
figure and deletes the transaction detail. You can still run comparative financial reports for a summarized fiscal
year.

Purging a fiscal year deletes all summary transactions for the fiscal year and prevents comparative reporting for
the year purged. We recommend you back up your database before you run these processes.

Question:

When should I run the end of year process?

Answer:

Run the process at any time after period 12 of your fiscal year. Keep in mind you can leave unlimited fiscal years
open in General Ledger.

Question:

When do most people close their fiscal year?

Answer:

Most organizations run the process only after they have received their yearly audit. This allows audit adjustments
in period 12 of the past fiscal year.

Question:

How do | know whether | should lock my FAS 117 balances or not?

Answer:

Your accountant should be able to tell you if you will need to produce the FAS 117 compliant statements for the
fiscal year you are closing.

Question:

| ran the end of year report and there were a few problems, which | corrected. Is it all right to re-run the report?
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Answer:

The end of year report should be run again until there is a successful report produced.

Question:

| am not ready to close the fiscal year, but | want to restrict users from posting to past periods in the General
Ledger. Is this possible?

Answer:

You can “soft close” a period by accessing the Fiscal Years page in Configuration. This prevents users from posting
to a specific period. If you need to change the period, the system administrator can remove the “soft close” at
any time.
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As the calendar year quickly comes to an end, it’s time to start preparing 1099s for your vendors. Before you
generate your 1099s, save time and money by verifying 1099 amounts and vendor information. You can start the
verification process in December for a smoother January.

Note: Blackbaud offers quality forms, pre-printed in color with your organization’s logo and information. For
details, call 866-4-BB-Forms, visit http://forms.blackbaud.com, or send an e-mail with questions to
forms@blackbaud.com.

When it comes time to create your 1099s, you must first install the end-of-year update. This update, available in
late December, ensures compatibility with IRS regulations and forms.

Instead of processing your 1099s directly through Mail in Accounts Payable, you can now connect to Aatrix. The
Aatrix integration combines your data with their content to populate the integrated reports in compliance with
state and federal tax agency regulations. The 1099-MISC and W-2 eFiling solutions provide a range of choices
from a complete full service eFiling option to a partial eFiling of just the federal forms, state forms or both.

While we recommend using the complete eFiling option as a best practice, you could skip the eFiling option
altogether and print to paper tax forms. Please be aware, there are costs associated with eFiling. Also the new
option to eFile 1099-MISC forms impacts your decision whether to purchase paper tax forms. To purchase
compatible preprinted paper tax forms for paper or the partial eFiling options, please contact the Blackbaud
Forms team at 866.422.3676 to speak to one of our trained tax forms specialists.

Creating 1099 Vendors

Tracking a 1099 vendor involves defining information in two key areas: vendors and invoices. On the vendor
record, be sure to enter the 1099 vendor’s tax identification number (TIN) in the Tax ID number field. This
information prints on the 1099 form.
» Setting up a 1099 vendor
1. Open the vendor you want to make a 1099 vendor.

25 - ADS Security Systems !E

File Edt Yiew “endor Favortes Tools Help
E]Saveandtlose-|n X||§§|H i bk N||E| @|E|| ? - |
Mates | Higtary of Changes I Media I Actions
Mendor I Activity | Becuring | Purchase Orders | Addresses | EFT Bank Infarmation | Digtribution | Aftributes
Yendor name: IADS Security Systems
Yendar 1D 25 Address: 4328 Elliot Circle ;I
I _I Charleston, 5C 29416
Status: IActiVe j _I
Cusztomner nurmber: (132165440 T
| Contact: | [Mr. Bill-Janes
Tan D number;  [45-76541255 S |
‘ozition: District M anager [ Frint?
Terms: INet‘IE vI :\:‘I
Contact Type | Contact Murmber |
v Credit limit |$1 ooo.oo | | Business (800) 455-8336
Payment method: IChBCk j ||
Fapment options: IUne payment for all invoices j User ID: I
Bank. account: |Dperating j PIN: I
v 1099 ¥endor? | €8 1033 Distribution...

| Active |

2. Enter a Tax ID number. This number can be a Social Security Number (##-#-####) or Employer

Identification Number (H##-#HiH#HE).
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3. Click Address and select the Options tab.

% Address for ADS Security Systems

General Options IEontactI

Accounts Payable Options

Name: I

Alias: I
I¥ Primary address for vendar
[T Default address far invoices

[T Default address for purchase orders

1059 Information -

1099 name: ISm_l,lthe, Riobert /.

1099 name 2: IDBA Artists In Residence Unlimited

v Default address far 1099 forms

QK | Cancel |

4. In the Name field, you can enter the vendor name you want to print on invoices, checks, and purchase
orders that use the same address. If you leave this field blank, the name on the Vendor tab prints.

5. In the Alias field, you can enter a vendor alias. You can use alias as a filter when trying to locate vendors
from the search screen. The alias you provide does not print on any documents.

6. Mark Primary address for vendor to indicate the address is the primary address for the vendor. The
primary address appears on all invoices and purchase orders unless you specify another address as the
default.

Warning: It is important that the combination of name control and taxpayer identification number (TIN)
provided on an electronically filed return match IRS’s record of name controls and TINs.
7. Mark Default address for invoices to indicate the address as the default address for all invoices.

8. Mark Default address for purchase orders to indicate the address as the default address for all purchase
orders.

9. Inthe 1099 name field, enter the name you want to appear as the Recipient on the 1099 form. This is an
optional field.

Please be aware that what you enter in this field is pulled into the magnetic media file to serve as the
name control value, and therefore, must be formatted correctly. You must enter a person’s last name first.
For organization names, the first four characters you enter will be used.

We recommend you review the rules in the Business Name Control matrix provided by the IRS to verify
your name control prior to e-filing.

10. The 1099 name 2 field is optional. If you enter a name, it appears on the 1099 form under the 1099 Name
field.

11. Mark Default address for 1099 forms to indicate the address as the default address for all 1099 forms.
12. To return to the Vendor tab, click OK.
13. Mark the 1099 Vendor? checkbox.
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14. Click 1099 Distribution. The 1099 Distribution screen appears.

15.

16.

i 1099 Distribution for ADS Security Systems I

1099 Box Number I State I Percent I

[7[1-Rents sC =]

Digtribute Evenly  Delete All... Remaining: 100%
[~ Put acheck in box 3 of the 1099 for this Yendar
[~ Put acheck in the '2nd TIN not.' box of the 1099 for this Yendaor

ak I Cahicel

In the 1099 Box Number column, select a default box number.

When selecting a default box number, please be aware that two new box codes have been added for 2005
reporting: 15a and 15b.

In the State column, select a state from the table. You cannot produce 1099 distributions for states until
you define states and state ID numbers on the General page of Configuration.

Warning: You can define states and state ID numbers on the General page of Configuration.

17.
18.
19.

20.

In the Percent column, enter a 1099 percent. You can use the calculator or click Distribute Evenly.
To delete the information you have entered in the 1099 grid, click Delete All.

To have Box 9 checked on printed 1099 forms, mark the Put a check in Box 9 of the 1099 for this Vendor
checkbox.

To have the ‘2nd TIN not.” box checked on printed 1099 forms, mark the Put a check in the ‘2nd TIN not.
box of the 1099 for this Vendor checkbox.

Note: Once you set up a 1099 vendor, you can edit the information by selecting Edit 1099 Default Distribution
from the Vendor menu.

21.

To return to the Vendor tab, click OK.

Adding Invoices to 1099 Vendors

When you add an invoice or credit memo to a 1099 vendor, the total amount of the invoice or credit memo is
distributed to the default 1099 box. You can edit the 1099 distribution:

¢ If you do not want the entire invoice amount to apply to a 1099 box, you can reduce the distribution.

¢ If you want the amount to apply to another box, or to more than one box, you can change the distribution.

¢ If you do not want the invoice amount to apply to a 1099, you can delete the 1099 distribution.
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To access the 1099 Distribution screen, click 1099 Distribution from the invoice record.

i 1099 Distribution for Invoice 47 I
I $ % |
1099 Bow Numnber State I Arnount I
B Oterrcome  RIEE $25.00

Digtribute Evenly  Delete &ll...

Upon payment of this invoice, the amount allocated to the 1099 box automatically updates on the vendor record.
The payment date determines the calendar year in which the amount is reported. For example, any invoices
entered in December 2004 but paid in January 2005 are reported on the 1099 forms printed for 2005.

Credit Memos

You should use a credit memo to withhold Federal or State tax from a 1099 payment. The 1099 distribution of the
amount on the credit memo would be Box 4 for Federal and Box 16 for State.

To access the 1099 Distribution screen, click 1099 Distribution from the credit memo record.

&% 1099 Distribution for Credit Memo C889

1093 Box Number

Dijziniowiz Evanly L Total: $0.00

ak. I Cancel

You should use separate credit memos for each entity, and then apply the credit memos to the 1099 invoice
before creating a payment.

If the business rule for invoices, “Change invoice status to paid when applied to credit reduces the balance to
zero” is selected, the 1099 amounts will not be recorded to the vendor when this condition is met.
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Adjusting 1099 Amounts

When verifying 1099 amounts in Accounts Payable, you may find some invoices that should or should not have
been marked to be included in the 1099 information. To correct this information for 1099 printing, you can adjust
a 1099 amount at any time by selecting Vendor, Enter 1099 Adjustments.

1099 amounts can be changed by creating a 1099 adjustment for the difference between the actual amount and
the correct amount. To change the 1099 amount or state, use the following steps or our interactive 1099 Wizard,
which takes you step-by-step through the process of making adjustments and correcting information.

If you discover a vendor whose 1099 activity has not been tracked throughout the year, ensure you mark the
vendor as 1099 and define a default 1099 distribution.

1099 Adjustments for AlphaGraphics ﬂ

Enter 1033 amounts not included on invoices:

Effective Date | 1099 Box Mumber | Stake I Armount |
| |12/31/2008 1-Rents sC $100.00
| |12/31{2003 1-Rents {$100.00)

Ok, I Cancel |

Note: If you have incorrectly recorded invoices for the 1099 box, you can enter negative amounts to decrease
the vendor balance.

Effective Date. Enter a date that specifies the calendar year for which the amounts should be recorded.
1099 Box Number. Select the 1099 box into which the amount should subtotal.

State. Select a state from the table. You cannot produce 1099 distributions for states until you define states and
state ID numbers on the General page of Configuration.

Amount. Enter the 1099 adjustment amount. Enter a positive number to increase the 1099 amount. Enter a
negative number to decrease the 1099 amount.

OK. To save, click OK. You should now be able to print the 1099 for this vendor with the correct total.

Reporting on 1099 Vendors

Warning: The IRS requires you to provide payees with their copy of the 1099-MISC by January 31. The
reporting to the IRS must be done by February 28/29 (March 31, if filing electronically).

To preview 1099 vendors and 1099 amounts, you can run the 1099 Activity Report. This activity-based report
provides summary information of payments made against invoices with assigned 1099 boxes. The information is
summarized by individual box and by vendor over a specified duration of time.

You should run this report prior to creating the 1099-MISC at the end of the year. If necessary, you can open the
vendor record and enter 1099 Adjustments.

For your vendors, print pre-printed laser 1099-MISC forms to mail by January 31.

For the IRS and/or state tax departments, print pre-printed laser 1099-MISC forms to report the information by
February 28. You can also create an electronic file to report the information.


http://www.blackbaud.com/support/faqs/1099.aspx

ACCOUNTS PAYABLE END OF YEAR 23

1099 Forms

You can create 1099s to report miscellaneous income you paid to vendors in a calendar year. Amounts reported
on 1099 forms are taken from the check date for checks printed during that calendar year. The address marked as
the primary address on the vendor record prints on the 1099.

Before you create 1099s for your organization, verify your organization’s Federal Identification Number is correct.

Print the amounts that have been entered on invoices or adjustments to 15a and 15b to the new box numbers on
the form.

You may need to report amounts in box 7 that you have reported in box 15b. We recommend you speak with
your tax accountant to determine if your organization should report amounts in both boxes.

1099 Forms Tabs

A 1099 has tabs on which you select parameters: General, Filters, and Attributes. To move among the tabs, click
Next and Back at the bottom of the screen or select the tab. On these tabs you specify the records to include in
the mailing and how the forms should look.

Warning: Before you can print 1099 forms, you must enter your organization’s Federal and State Identification
Numbers in Configuration.

1099 General Tab

On the General tab for 1099 forms, you select parameter settings specific to 1099s.

Generate 1099s for. In the Generate 1099s for field, you can select the year for which you want to print 1099
forms.

Corrected return. If you mark the Corrected return checkbox, forms print as corrected returns and are marked
accordingly on the 1099s.

Include activity below minimum. If you mark the Include activity below minimum checkbox, 1099s print for
vendors who do not meet the minimum amount required by the IRS for 1099 reporting. Marking this
checkbox activates the Include vendor with no activity checkbox.

Include vendors with no activity. If you mark the Include vendors with no activity checkbox, the program
creates 1099s for vendors with no 1099 activity for the year.

Use an alternate payer/file name. If you mark the Use an alternate payer/file name checkbox, to enter an
alternate name for the vendor.

Name. In the Name field, enter a contact name or number, up to 40 characters. Enter the phone number and
Email address fields.

Note: From the General tab, you can also print totals to use on a Form 1096. This summary prints on a
separate sheet of paper after the 1099 forms.

Print 1099 Forms. Mark Print 1099 Forms, and additional selections for printing 1099s are enabled. Mark Print
payee account # to select to print the vendor ID, attributes, customer number, or system ID. To print summary
information for a Form 1096 after the 1099s, mark the Print 1096 summary checkbox.

Note: Click Preview to view the form as it will print using your selections and filters. Click Layout to view a
sample layout of the form without data.

Create an output query of vendors. To create a query of vendors you run 1099s for, mark Create an output
query of vendors. You can save and use an output query later for other mailings or reports.

Report Orientation. 1099s automatically print in portrait orientation (vertically).
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1099 Filters Tab

You can use the Filters tab to include records based on selected criteria such as vendors or vendor attributes. For
example, you may not be preparing 1099s for all vendors at one time. You can include only those vendors whose
names begin with A through H.

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click Open
on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

1099 Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for the vendors whose 1099 forms you
generate. For example, when printing 1099s for vendors with an attribute type of 1099 Printed and a description
of Yes, you can update the date to record the date for 1099 printing the next year.

Action. In the Action column, you can select to add, delete, or update attributes on the vendor record when you
generate 1099s.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Additional End-of-Year Resources

Have additional questions about the end-of-year process? Check out these resources:

¢ Knowledgebase to find answers to how-to questions and troubleshoot software issues.

e Forums to discuss best practices with your peers and review shared Client Documents.
¢ Blackbaud Forms to order W-2 and other tax forms.



http://www.blackbaud.com/kb/index?page=home
http://forums.blackbaud.com/forums/66.aspx
https://www.blackbaud.com/blackbaud-forms
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Closing the school year with Student Billing is a multiple step process to reconcile the ending school year and
prepare for the upcoming school year.

Note: For electronically filed 1099-MISC and 1098-T forms, please see IRS Publication 1220 to review the
magnetic media changes.

We strongly recommend you read this chapter completely before you begin the end of year process.
With the Student Billing end of year process, you can complete the following tasks:

¢ Copy and edit billing items and bill codes that are used from one school year to the next and add new billing
items and bill codes as necessary.

¢ Promote students to the next grade.
¢ Verify and edit student information.
¢ Post to General Ledger.

Student Billing End of Year Checklist

Warning: The end of year process creates vast changes to the database and can be reversed only by restoring
to a backup. Backups essential in completing your end of year process. Without a valid backup, you cannot
correct inappropriate changes made in the database during the process.

To reconcile an ending school year and prepare Student Billing for an upcoming school year, we recommend you
follow each step of the checklist in order.

U Post to General Ledger.

U Reconcile Student Billing to General Ledger.

U Print end of year reports for the current school year.

Q Copy and edit billing fees that are used from one school year to the next and add new billing fees as necessary.

Qi you use bill codes on your student records, define them for the next school year. Copy and edit bill codes that
are used from one school year to the next and add new bill codes as necessary.

U Promote students to the next grade.
Q Verify and edit student information, such as addresses and relationships.

Posting to General Ledger

If the school year coincides with the fiscal year in General Ledger, make sure you post all current transactions
before you close the fiscal year. If the school year and fiscal year do not coincide, you have more flexibility.
However, to maintain consistency, we recommend you post all items before the end of the school year.

If you are planning to purge transactions, you must post all transactions or mark them as Do Not Post.
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» Posting to General Ledger
1. From the Administration page in Student Billing, click Post. The Post page appears.

[he Ldt Wew Go Fawontes Jools pisk
# Back % Forward |mnmmientssh:.' * Student Billing -

Wame | Descripton | Lot pasted by | Loct posted on |

[ Wiekecaie to Studert Biling |

2. If any post parameter files have been saved, they appear in the grid. To open an existing post, select it
from the grid. To create and post a new parameter, see “Creating and posting a new post parameter file”
on page 28.

3. To print a Batch Validation Report to review before posting, select the parameter file and click Preview on
the action bar. When the processing finishes, a validation successful message appears.

4. Click OK. A Batch Validation Report appears.

5. To post, select the parameter file and click Post on the action bar. When the processing finishes, the Post
Successful screen appears.

6. Click OK. A Post Report appears and you return to the Post page.
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» Creating and posting a new post parameter file
1. From the Administration page in Student Billing, click Post. The Post page appears.

2.

3.

[he Ldt Wew Go Fawontes Jools pisk
rmunity Services Inc. =+ Student Billing -

Administration = Post

Mew Post Passmeter Oper Delite | Preview Fost Fnd

£
£

Hame | Desription | Lastposted by | Last postedon |

i

i

i

mﬁi L

i zgé\i

EEES]

_?

il

[ Wiekecaie to Studert Biling |

Click New Post Parameter on the action bar. The New Post Parameter screen appears.

B New Post Parameter ;IEILI
File Edit Wew Favorites Tools Help
BSaveandCIosevhﬂ J\_|ul d‘3|4.'|:l'|?‘ |
General | F!Itelsl Fgrmatl
Past Student Biling transactions with this journal code: IStudenl Eillirg ﬂ
[¥ Create an output file of posted transactions in this farmat: ICumma-SeDaraled Walues j
Expart file name: I ;I

Select the journal reference to uze for each transaction twpe:

Journal Reference

Reference Type I

Debit
Credi

<Default> Last Mame/Org Mame <HyphenzTransaction Tvpe <Hyphen=C...

<Default =

Interfund entry

Last MamejOrg Mame <Hyphen=Transaction Type<Hyphen=C...

|Press F7 for file lookup ‘

4

In the Post Student Billing transactions with this journal code field, select a journal code.

4. To create an output file, mark Create an output file of posted transactions in this format, and select a file
format. In the Export file name field, enter a file name or click the ellipsis to browse.

Note: To return a journal reference to its original format, in the Reference Type column, select “<Default>".

5. To customize the journal reference format for debits and credits for each transaction type, in the Select

the journal reference to use for each transaction type frame, select a
the left. A grid appears on the right.

In the Reference Type column, select “Custom”.
In the Journal Reference column, enter the format.

transaction type from the list on
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6. Select the Filters tab.

B New Post Parameter -10f x|

File Edit Wiew Favorites Tools Help
uSaveandclosev‘u |{_Qé|'_?| . | oot

General  Filters IFgrmall

? -
i

Include tranzactions with post dates in this date range.

Puost date: Include all dates

Include tranzactions with document dates in thiz date range-

Document date Ilnclude all dates 1%

¥ Include deposits whose actual receipt totals do not match the projected totals

Filters Include Selecked Filkers Iﬂ
Records all <Al Records
Record Types all <All Record Types>
Student Attributes All <Al Student Attributes >
Individual Attributes Al <Al Individual Attribubes >
Organization Attributes al <Al Organization Atkributes>
harnes al 2ol rharness d|
alidate Post
| | 4

7. Inthe Include transactions with post date in this date range frame, in the Post date field, select a specific
date or date range of posted transactions to include.

If you select “<Specific range>", specify start and end dates.

¢ If you leave the Start date field blank, all activity up to the end date is included.

¢ If you leave the End date field blank, all activity from the start date to the present is included.
¢ If you leave both the Start date and End date fields blank, all activity is included.

8. In the Include transactions with document dates in this date range frame, in the Document date field,
select a specific date or date range of posted transactions to include.

If you select “<Specific range>", specify start and end dates.
9. To filter transactions, in the Include column for each filter type, select “All” or “Selected”.

If you choose “Selected”, the Selected screen appears so you can select the filters to create the new post
parameter. Make your selections and click OK. You return to the Filters tab, and the filters appear in the
Selected Filters column.

10. Select the Format tab.

B New Post Parameter o [=[ 3]

File Edit Wiew Favorites Tools Help
[L]Saveandlilnsev‘ﬂ |m.é|?| - |.)|?,

Eenera\l Filters Fgrmatl

I Use the default Post Report parameters

|
I Previgw j I

[~ Print contral report on I

Ll 1 2] 1]

or_|
|

| BN
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11. In the first field, select:

e “Use the default Post Report parameters” to use the Post Report parameter files established on the
Post Options link of the Records Options tab for General Ledger.

e “Always ask for a parameter file” to use a parameter file you select or create each time you post.

e “Always use this parameter file” to use a parameter file you select the first time you select this option
for every time you post.

If you select “Always use this parameter file”, click the binoculars at the second field. The Select a

Parameter File screen appears.

Select a Parameter File

Select a parameter file to uze for Batch Yalidation R eport

Select

%] Cancel

] Add New
(1 Open

&8 Find...

didid

[ Only show my parameter files

Select or add a parameter file and click Select. The New Post Parameter screen appears.

*

B New Post Parameter =101 x|

File Edit Yiew Favorites Tools Help

BSaveandClosev|[ﬂ |L_J.‘; d| '?| . | = g

?- |

Qenelall Filters Fgrmatl

parameter file

|Batch Dretail with Transaction level

I Preview j I

™ Print contal repart on I

L L 12

ot |
[ \ y
12. Inthe next field, select “Print” or “Preview”. If you select “Print”, select a printer.

13. To print a control report, mark Print control report on and select a printer in the field to the right.

14. Click Save and Close on the action bar. The Save Post as screen appears.

X
Post name: | & Save |
Description; :I Catcel |

¥ Others can run thiz Post
[+ COthers can modify this Post

15. In the Post name and Description fields, enter the file name and description.
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16. Mark whether others can run or modify the post.
17. Click Save. You return to the Post page.

18. To print a Batch Validation Report to review before posting, select the parameter file and click Preview on
the action bar. When the processing finishes, a validation successful message appears.

19. Click OK. A Batch Validation Report appears.

20. To post, select the parameter file and click Post on the action bar. When the processing finishes, the Post
Successful screen appears.

21. Click OK. A Post Report appears and you return to the Post page.

Reconciling Student Billing to General Ledger

To ensure student billing activity is correctly reflected in General Ledger, reconcile Student Billing to the
accounts receivable account in General Ledger. For more information on reconciling Student Billing to General
Ledger, see the Subsidiary Ledger Reconciliation Guide.

Printing End of Year Reports

Before you proceed, print important Student Billing reports. You can use these reports for audit documentation
and as a reference point to compare data from before and after the end of year process is complete. At a
minimum, we recommend you print these reports:

e Account Activity Report — Lists all activity for students and payers, such as charges, credits, and payments.
¢ Account Balance Report — Lists students with their grade, payers, and account balance.

¢ Account Distribution Report — Lists debit and credit amounts for General Ledger accounts created from
charges, credits, payments, and any adjustments.

e Aged Accounts Receivable Report — Lists the past due status of each student and payer.
¢ Open Item Report — Lists the accounts received by paid and unpaid amounts.

» Printing a report

Note: An action bar containing links for creating a new report, opening a report, and deleting a report appears
above the list of reports. These links are common to all reports pages.

1. From the Reports page in Student Billing, click the report to print. The selected reports page appears.

SETE
Dl Lt ¥ew Go Fyeorkes Jools ek

* Back * ¢ Carnmunity Services Inc. = * Student Billing -

12 Reports - Transaction Reports

Mew Ogen Delese.. Heports
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L Account Activity Report Rsports
B Finpast
2] fbvernce Depost Hepal Arslyss
T EFT Report F
7 Frusrasd fud Sedechde el
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7] Prcjeect Distribution Fieport
2] e | o Fimpcet
3] Tearsaction List
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2. Inthe list on the left, select the type of report to print. Saved reports of that type appear on the right.
3. Inthe grid on the right, select the specific report to print.
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4. From the menu bar, click File, Print. A message appears telling you the report is printing. When the report
finishes printing, you return to the reports page.

Copying and Adding Billing Items and Bill
Codes

You can copy and edit billing items and bill codes that are used from one school year to the next and add any new
billing items not previously defined for any school year. Usually, only slight changes, such as new tuition and other
fee amounts, are needed as billing items for a new school year. If your organization needs only an increase or
decrease by amount or percentage on the items, we recommend copying the billing item information. Copying
reduces the amount of data entry and helps prevent data entry mistakes.

Billing Items

On the Products and Billing Items page, you can copy billing items that are used from one school year to the next
and increase or decrease the amount by a specific dollar amount or a percentage. You can select specific records
to copy, or you can copy all billing items. If you copy a billing item with pricing schedules, the last schedule is
copied and changed to reflect the new prices.

You can create new billing items for services you will offer in the new school year. After you add a billing item in
Student Billing, you can edit or delete the record as needed.

When you create a default product distribution on the GL Distribution tab, it automatically appears on the related
charges and credits.You can add the products and billing items:

¢ Flat Rate Items — Charges a specific amount regardless of the quantity or other factors; for example, a $250.00
lab fee.

¢ Per Usage Items — Charges the student based on the number of times the item is used, such as an hourly rate
for counseling services.

¢ Products — Defines product records and pricing schedules for items or services you will offer in the new school
year.

¢ Refund Items — Disburses credit by printing a check payable to the student or by applying the refund to another
active charge.

¢ Finance Charge Items — Charges students for the costs of financing a debt.
¢ Sales Tax Items — Charges students for purchasing certain items designated taxable by state or local law.

¢ Advance Deposit Items — Charges a refundable amount to reserve a student’s place in a future school term.
When the full payment is received, advance deposits generate credits to refund monies or reduce the student’s
existing charges.

¢ Financial Aid Items — Used as a default for creating financial aid records, which are applied to student records to
reduce the amount owed.

¢ TRP Items — Defines the tuition refund plan (TRP) percentage charge and General Ledger account to use to post
this type of transaction. You can enter the particular TRP percentage established by your school.

¢ New Automatic Item: Vary Amount by Grade — Charges the amount defined for a given year according to the
specified grade level.

¢ New Automatic Item: Vary Amount and Schedule by Grade — Charges payer specific amounts based upon the
grade level and a unique schedule defined for that grade level.

¢ New Automatic Item: Single Amount and Schedule — Charges based on a common amount, assigned to
individuals and organizations.
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» Copying billing items

1. On the Configuration page in Student Billing, from the menu bar, select Tools, Copy Products/Billing

Items. The Copy Products and Billing Items screen appears.

Etopy Products and Billing Items =131 =]

1: General |Z: F|Il&|s| B F'rewew'

Include products and billing iterms with these dates -

“Walid from date within: Ilnclude all dates Vl
Walid b date within: Ilnclude all dates vl

[V Change unit/per usage price of copied iterms by Iamount -
Ilncrease - l original amout by I [=]

|~ Change unit price on pricing schedules of products

[~ Change schedule dates that fall an a weekend to I The previous weekday ‘l

[ Frirt & contral report on j

< Back | Next = | Cancel | F're-cupyrepurll Copy now |

| | A
In the Include products and billing items with these dates frame, select a date or date range in the Valid
from date within and Valid to date within fields.

If you select “<Specific range>", specify a start and end date. If you leave the Start date field blank, all
activity before the end date is included. If you leave the End date field blank, all activity after the start
date is included.

To change the unit or per usage price of the copied fees, mark Change unit/per usage price of copied
items by and select “amount” to change the dollar value of the fee or “percent” to change the fee value
by a percentage.

Select to increase or decrease the amount or percentage, and then enter the change value in the original
amount by field.

To change the price on the copied item pricing schedules, mark Change unit price on pricing schedules of
products.

To change the schedule dates from weekends, mark Change schedule dates that fall on a weekend to and
select “The previous weekday” or “The next weekday”.

To print a control report, mark Print a control report on and select a printer.
Click Next or select the Filters tab.

Etopy Products and Billing Items =131 x|
1: General 2 Filters |§: Previewl

@5 0pen 7 Clear &ll Fiters

Filkers I Include Selected Filters

Products and Eiling Item Types Al <Al Praducts and Eilling Item Types:>
Products and Biling Items all <Al Products and Billing Items=
Product and Billing Item Attributes Al <Al Praduct and Billng Item Attributes=

< Back Hext > Cancel Pre-copy report | Copy now |

| 4
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7. You can filter by products and billing item types, products and billing items, and product and billing item
attributes. In the Include column for each filter type, select “All” or “Selected”. To copy only billing items
with specific information, choose “Selected”.

If you choose “Selected”, the Selected screen appears so you can select the billing items to copy. Click OK
and you return to the Filters tab. The filters appear in the Selected Filters column.

8. Click Next or select the Preview tab. Products and billing items that meet your specifications appear in the
grid.

ﬂtopy Products and Billing Items =10l x]
1: Generall 2 Filkers ~ 2: Preview
Copy? Item Type ©ld Start ©ld End Tews Stark Mew End Old Amount | Mew Amounk !
¥ PURGE BAL Flat Rate Item 07/01/2006  06/30/2007  OF(01/2007  08(30/2008
¥ BOCKS Flak Rate Ttem 07/01/2009  06/30{2010  07j01/2010  0&/30/2011  $0.00 40,00
¥ TUTOR Per Usage 1., O7/01/2009  06/30{2010  O7j01/2010 06(30/2011  $25.76 §25.76
¥  REFUND Refund Ttern  O7/01j2009  06/30f2010  07/01/2010  06/30j2011
¥ FINAMCE CHG Finance Ch... 07/01/2009 06/30f2010 07/01/2010  06/30/2011
¥ TRP TRP Charge... D7/01/2009  06/30/2010  OF/0L/2010  06f30/2011
¥ AID ANMUAL Financial &id  07/01j2009  06/30{2010 070142010  0/30/2011  $0.00 40,00
¥ ADVDEP Advance D... 07/01/2009 06/30{2010 07j01/2010  0&/30/2011  $0.00 40,00
[V AIDSEMI Financial 4id  07/01/2009  06/30/2010 07012010  06/30/2011  $0.00 $0.00
¥ AID 10PAY Financial &id  07/01j2009  06/30{2010  07/01/2010  0/30/2011  $0.00 40,00
[V TUITIOM AMMUAL  Automatic L., 07/01/2008 06/30/2009 07/01/2009 06/30/2010 $14,422,80 $14,422,80
[V TUITIOM SEMI AM... AutomaticI... O7f0Lj2008 O08f30/2009 OF/01/2009  06/30/2010  $14,937.90  $14,937.90
[ TUITIOMTEMPAY  Automatic I.. 07/01/2008 06/30/2009 O7/01/2009 06/30/2010 $15,246.96  $15,246.96
¥ GRaD Automnatic .. 07/01/2008  06/30{2000  07/01/2009 06/30/2010 250,00 $250,00 =
< Back | HEsts | Cancel | Fre-copy report | Copy now |
| 4

9. To copy all records, click Select All.

To unmark all checkboxes, click Deselect All.

To select specific records to copy, mark the checkbox in the Copy? column.

10. To view a report of the records to be copied, click Pre-copy report.

11. To copy the products and billing items selected, click Copy now. A processing screen appears. When the
process is complete, a screen of the products and billing items copied appears.

Note: The number of records that did not copy successfully appears in the Exceptions row of the grid.

12. When you close the screen, a screen appears displaying the number of records processed and the number
of exceptions.

Copy Products and Billing Items

Processing Completel

. Copy Products and Billing ltems

Processed:

19

Exceptions:

Cloze || Wiew Control Report I

13. To view the control report of the copied records, click View Control Report.

14. To return to the Products and Billing Items page, click Close.
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» Adding a billing item

1.

T ihe inancisl Ldoe
e Edt Yew o Fovorkes Jook Help

From the Configuration page in Student Billing, click Products and Billing Items. The Products and Billing
Items page appears.

=18l
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% e * Configuration « Products and Billing Items
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(N Tutaring Fee urfonfas 0 507006 fctive Lt

2. Click the down arrow next to New Flat Rate Item and select a billing item. For example, to add a new per

3.
4.
5.

usage item, select New Per Usage Item. The <ltem Type> Item screen appears.

. New Per Usage Ttem

File Edit View BilingItern Fawvorites Tools Help

B save ondCiose <[ [ [ 1a S| M < b m| ]2 -

x]

=1l x|

Item ID: | - Status; IADlive -

Deescription: I
Dates: Item can be used on ary date 'I

ltem | GL Distibution | Attibutes | Netes |

Uit price decimals: |2_:|| 7 Allow user to edit unit price on transactions
Quantity decimals: Ia_j

Default valies: [ o of Measure_| Quartity | unit Price

Extended Amount

0,000

I ltem is subject to sales tax: - I ltem is eligible for discount

I™ ltem is subject ta finance and late charges

I Limit chages tor | per: |Ehalge for Recard j
Limit charges by |<AH dales E
IF a charge would exceed the limit: | Display 2 warring message ¥

Comment:

[ v

In the Status field, select “Active” or “Inactive”.

In the Item ID field, enter an identification number for the billing item.

In the Description field, enter a description to help identify the billing item.

Tip: To enter today’s date, press the F3 key. To open the calendar, click the calendar or press the F7 key.

6.

In the Dates field, select the dates the billing item: “Item can be used on any date” or “Item can only be
used from”. If you select “Item can only be used from”, enter the dates during which the billing item can
be used.

7. Complete the Item, GL Distribution, Attributes, and Notes tabs for the new billing item.
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8. Click Save and Close. You return to the Products and Billing Items screen, and the new billing item
appears in the grid.

Bill Codes

Bill codes link billing items and student, individual, or organization records. When you generate transactions
automatically, Student Billing matches the bill codes on the records to the bill codes on the billing items to create
billing schedules and generate charges.

» Copying bill codes

1. From the Administration page in Student Billing, click Copy bill codes. The Globally Add Bill Codes screen
appears.

Globally Add Bill Codes 3 |

File Help

R ?-

Add new bill codes or copy existing bill codes ta a group of records

Action: &,dd Bill Codes

Gluery name: I ﬂ
Bill Code: I j

From: I Ta: I gl

[~ PFrirt control report I~ Create exception quen

Cancel | Preprocessing Report | Add Mowe |
| |
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4.

3.

2.

Buery type: I Recard j Description: I
Query farmat: I j Created by: I
Query name: || j Created on:

Globally Copy Bill Codes

File Help

@l

Add mew bill codes or copy exigting bill codes to a group of records

Action:

Bill Codes

Query name: ﬂ
Copy bill codes ending on: I il

I~ Print contral repart [~ Create exception quemn

hizlude these bill codes:

D escription I [ escription

Annual Pagment Plan

Semi Annual Plan
Ten Payment Plan

2l ¥l

Cancel |

PFreprocessing Report |

In the Query name field, click the binoculars.

In the Action field, select “Copy Bill Codes”. The Globally Copy Bill Codes screen appears.

The Open Query screen appears.

Dpen Query

Findt: I [uery j

[ iz ﬁ Add a Mew Query

Optiohs

Hide Filters | Clear Filtersl Previous FiItelsI Filters are not applied Find Maw I
|F'ress F7 to zoom

{0 J]=lg] I

Cancel I

In the Find Queries that meet these criteria frame, enter the criteria to find the group of records.

5. After you enter the search criteria, click Find Now. The program searches the database, and all groups of

records that meet your criteria appear.
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6. Select a group of records and click Open. The Globally Copy Bill Codes screen appears.

Globally Copy Eill Codes |

File Help

NERE |

Add new bill codes or copy existing bill codes to a group of records

Aetior:  [Capy Bil Cades |
Query name: IAII students ﬂ

Copy bill codes ending an: I EII

I~ Print control repart I~ Create exception query
Include these bill codes:
Dezcription | Description
Annual Payment Plan
Semi Annual Plan
Ten Payment Plan

alr Bl

Cancel | Preprocessing Report | LCopy Maw |

|F'ress F7 for query lookup |

Tip: To enter today’s date, press the F3 key. To open the calendar, click the calendar or press the F7 key.

7.

In the Copy bill codes ending on field, enter the date on which the bill codes to be copied end.

8. To print a control report on your default printer, mark Print control report.

10.

11.
12.
13.

14.

15.
16.

To create a query of records not included in the process, mark Create exception query.

In the Include these bill codes field, select the bill code descriptions from the list on the left to include in
the process.

To view a preprocessing report, click Preprocessing Report.

To copy the bill codes to the selected group of records, click Copy Now. A confirmation message appears.
To continue the copying process, click Yes.

¢ If you did not mark Create exception query, a processing screen appears.

¢ If you mark Create exception query, the Save Static Query screen appears. Click Save. A processing
screen appears.

Once the copying is complete, a screen appears displaying the number of bill codes copied and the
number of exceptions.

To view a control report, click View Control Report.
To return to the Administration page, click Close.
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» Globally adding bill codes

1. From the Administration page in Student Billing, click Copy bill codes. The Globally Add Bill Codes screen
appears.

Globally Add Eill Codes i |
Fil= Help
QR ?-
Add new bill codes or copy existing bill codes to a group of records
Action:
Quemny name: I QI
Eill Code: I j
Fram: I Ta: I
I Frirt control report [ Create exception quemys
Cancel | Preproceszzing Report I Add Mow |
2. Inthe Query name field, click the binoculars. The Open Query screen appears.
Dpen Query x|
Find: IGuel}l j
& = A addaN ew Query Options
M| Exact match only
Queny bype: IHecord j Diescription: I j
Query format: I j Created by: I ﬂ
Quem narme: || j Created on: I i]
Hide Filters | Clear Filtersl Previous Filtelsl Filters are not applied Find Maw I [Hpen | Cancel |
|F'ress F? to zoom
3.

In the Find Queries that meet these criteria frame, enter the criteria to find the group of records.

4. After you enter the search criteria, click Find Now. The program searches the database, and all records
that meet your criteria appear.
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5. Select a group of records and click Open. The Globally Add Bill Codes screen appears.

6.

Globally Add Eill Codes x|

File Help

QR - |

Add new bill codes or copy existing bill codes ta a group of records

Action:

Query namne: IAII shudents QI
Bill Code: I j

Fon | 3| 3

[~ Print contral report I~ Create exception query

Cancel | Preprocessing Report | Add Maw |
| |

In the Bill Code field, select the bill code description to add to the selected group of records.

Tip: To enter today’s date, press the F3 key. To open the calendar, click the calendar or press the F7 key.

7.

In the From and To fields, enter the date range for the added bill codes.

8. To print a control report on your default printer, mark Print control report.

10.
11.
12.

To create a query of records not included in the process, mark Create exception query.

To view a preprocessing report, click Preprocessing Report.

To add the bill codes to the selected group of records, click Add Now. A confirmation message appears.
To continue the adding process, click Yes.

¢ If you did not mark Create exception query, a processing screen appears.

¢ If you mark Create exception query, the Save Static Query screen appears. Click Save. A processing
screen appears.

Once the copying is complete, a screen appears displaying the number of bill codes added and the
number of exceptions.

The Financial Edge - Globally Add Bill Codes ﬂ

. The Financial Edge - Globally Add Bill
. Codes Completel

| fBill Codes processed: 52!
Bill Codes added: 51

Exceptions: 1

Cloge || Wiew Control Report I
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13. To view a control report, click View Control Report.
14. To return to the Administration page, click Close.

» Adding bill codes to a specific record
You can add bill codes to a specific student, individual, or organization record.
1. From an open record, select the Bill Codes tab.

O Hunter Adams & 10l x|
File Edit Yiew Student Favorites Tools Help

uSaveandCIosev||ﬂ|@v|N 4 kW ﬂ?|ﬁl|g|j|?v |

Defau_ItSc..I Payers |Statements|EFT Banl_ﬂsIAgtomatic...I Actionz IAttriI;utesI Motes I Media I Hiztory I
Bioll Bio 2 | Addresses | Addressees/S alutations | Relationzhips | Activitg  Bill Codes | F_inancialAid.&ppIicationl

™ Delets.. Copy from...

Eill Code Description Skark Date End Date

2. Inthe Bill Code column, select the bill code to add. The bill code description appears in the Description
column.

Tip: To enter today’s date, press the F3 key. To open the calendar, click the calendar or press the F7 key.

3. Inthe Start Date and End Date columns, enter the date range the bill code begins and ends.
4. To save your changes and close the record, click Save and Close.

Promoting Students

When the school year is complete, we recommend you promote your students. The students are promoted
according to the Promotion Schedule you defined in Configuration.
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» Promoting students

1. From the Administration page in Student Billing, click Promote students. The Promote Students screen
appears.

i, Promote Students x|

File Yiew Help

a2

1: General

a Filtersl 3 Attributes | 4: Preview

Update retumning students

Billing status: | =l
¥ Update graduating students

Billing status: I j

Errolimert status: I =]

Graduation date: I‘I 0411/2005 EII
Date enrolled to: I‘I 0142005 EII
Reason left: | j

[~ Update grads left

[~ Create exception query of students
I~ Create output query of students
[~ Print a contral report on I j

< Back | Mext > | Lancel | Prepracessing Fleportl Process Maw I

|F'ress F7 for table lookup |

2. Inthe Billing status field, select the billing status to use for returning students.
3. To update the status of graduating students, mark Update graduating students.

¢ In the Billing status, Enrollment status, Graduation date, and Date enrolled to fields, select the
statuses and dates to which the student is enrolled.

¢ To indicate a special reason the student left, in the Reason left field, select “Relocation”, “Transfer”, or
“Medical”. Otherwise, leave the field blank.

¢ To update the Grade left field on the student records to the grade of the students before graduating,
mark Update grade left.

4. To create a query of students not included in the promotion, mark Create exception query of students.
5. To create a query of students included in the promotion, mark Create output query.
6. To print a control report, mark Print a control report on and select a printer.
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7. Click Next or select the Filters tab.

. Promote Students x|
File Wiew Help
SIEIRE \
1: General 2 Filbers I§: Attributesl 4 Pleviewl

&5 Open 5, Clear All Filters

Filters | Include | Selected Filters |

Skudents Al <Al Students =

Current Grades Al <Al Current Grades >

Billing Statuses Al <4l Biling Statuses:

Owiner Bill Codes all Al Owner Bill Codesz

Skudent Attribukes Al <Al Student Atkributes =

< Back | MHest » | Lancel | Prepracessing Report | Process Mow I

Note: To be included, the Owner Bill Codes selected must apply to the current date.

8. To filter the records included in the promotion, in the Include column, select “All”, “Selected”, or, for the

Owner Bill Codes filter only, “None”.

9. If you choose “Selected”, the Selected screen appears so you can select filters to promote students. Make
your selections and click OK. You return to the Filters tab, and the filters appear in the Selected Filters

column.
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10.

11.
12.
13.

14.

Note:

15.

Click Next or select the Attributes tab.

. Promote Students x|
Ele Wiew Help
QR -
1 Generall 2 Filters ~ 2: Attributes Iﬂ: Pleviewl
Action I Attribute Type | Description I Short Description Date | Required |
| r
4] | il
< Back | Hext » | LCancel | Preprocessing Report | Process Mow I

In the Action column, you can update, add, or delete student attributes during the promotion.

In the Attribute Type column, select an attribute type.

In the Description column, enter or select a description for the selected attribute type.
If you select an attribute type that uses a short description, select its description in the Short Description

column. The Description column updates automatically.

In the Date column, enter the date you add the attribute or another date relevant to the attribute.

If the attribute is required, Required is marked.

In the Comments column, enter any additional information about the attribute.
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16. Click Next or select the Preview tab.

17.
18.
19.
20.
21.

L X
Eile Wiew Help
a2 2- |
1: Generall 2 Filtersl 3 Attibutes & Preview
Pramate? | Student I | Student Mame | Previaus Grade | Mexk Grade |ﬂ
v STUDZ3 Greq Skuart Atreva 01 01
v 0319 Paul Beisel 01 it}
v 0315 Jason Dugas 01 01
I STU0ZS oy Perez o o
I STUO04 Michael John Steinmeyer o o
v 0130 Dora Butler 0z 0z
v 0132 allison Carmichael 0z 0z
v 0128 Thamas Connelly 0z 0z
I 0316 Kevin Dugas 02 02
v 0317 Susan LaMonica 0z 0z
v o1za Elijah Shuart 0z i
v 0127 Jaroh Walker 0z 0z
v 0131 Maura Woods 0z 0z
v 0125 Hannah Elake 03 03
' nza Saan Hece n= n= ﬂ
< Back | THest > | Lancel | Frepracessing Repart | Frocess Maw I
[Included: 247 Excluded 0 [

To deselect a student for promotion, unmark the checkbox in the Promote column.
To review the changes before processing, click Preprocessing Report.

To promote the students, click Process Now. A confirmation message appears.

To continue the promotion process, click Yes. A processing screen appears.

Once the promotion is complete, a screen appears displaying the number of students processed and the
number of exceptions.

Promote Students x|
"~ Promote Students Completel
# of Students Included 246!
# of Students Processed 246
# of Exceptions i}
Elapsed Time 00:00:13
Cloze | | Wiewy Control Report I

22. Toview a control report, click View Control Report. Otherwise, to return to the Administration page, click

Close.

Editing and Verifying Student Information

Warning: Before you begin processing the next school year, make sure the student profile information is
correct.
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After the students have been promoted, we recommend you review and manually update any student records.
Sometimes, biographical, parent/guardian, or billing information is incorrect, and changes are needed. The
Student Profile Report shows the student record and summary transaction information for a specified period of

time.

» Creating a new student profile report

1. From the Reports page in Student Billing, click Student/Individual/
Organization Reports. The Student/Individual/Organization page appears.

2. Inthe list on the left, select Student Profile Report.

[ The: Financial Edge {Sampile Dat.a)
[le Edt wew Go Fgwontes Jools pel
Community Services Inc. * + Student Billing *

* Dack # oo
12 Reports - Student/Individual/Organization Reports

Hew Dpen Delete

7] Aoeount Baance Repart

1 Famdy Dreclony

2] Indenidusl Profle Repont

] (ngancahion Finkke Hepor
2] Payment Responsibiity Repar
] Reroud Statissies Repont

Sludent Prohle Reporl

SETE]

I3 New Student Profile Report
File Edit

BEa3a@ = 2-

‘Wiews Favorites Tools  Help

1: General IZ: Fillersl an Formatl

Show these repart sectiohs: Show these details:

v &ddress Information a| |[v 55N

[¥ sddiessees/S alutations [¥ Mickname

[V Relationships [V Current grade

[¥ Enraliments [V advisor

[~ Account Summary [¥ Homeroom teacher
[¥! Bill Cades [ Hameraom

¥ Finanrial Aid = | itk dete

[™ Show ending balance as of -
Az of date: IToda}l vl 101242005

I | Beduce balanee by ungenerated financial aid?

I | Beduce balanee by unaenerated| advance deposits?

Show year-to-date information as: IThig figcal pear vl 07140742008 ba 12431 /2005

[~ Create an output query of students

Report onentation; I Partrait e I

< Back | Mest » | Cancel | Frint | Preview |

Layout |

4. In the Show these report sections box, mark the student information to include in the report.

5. In the Show these details box, mark the more detailed student information to include in the report.

6. To show the ending balance for the students, mark Show ending balance as of. In the As of date field,
select “Today” or enter a specific date for reporting ending balances.

To reduce the ending balance calculations and account summary balances for ungenerated financial aid or
advance deposits, mark Reduce balance by ungenerated financial aid and Reduce balance by

ungenerated advance deposits as necessary.
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7. If you mark Account Summary in the Show these report sections field, select “This fiscal year”, “This
calendar year”, or “The year beginning on” in the Show year-to-date information as field.

If you select “The year beginning on”, enter the date on which the year begins in the Date field.
8. To create a query of the student records created for the report, mark Create an output query of students.
9. Inthe Report orientation field, select “Portrait” or “Landscape” to indicate how you want the report

printed.
10. Click Next or select the Filters tab. You can filter by Students, Current Grades, Billing Statuses, and Student
Attributes.
I New Student Profile Report x|
Eile Edit \iew Favaorites Tools Help
oS o= 2- \
1: General  2: Filters |3: Format'
&5 Open 7, Clear All Filters
Filters I Include I Selected Filkers
Skudents All <Al Students >
Billing Statuses all <Al Biling Statuses =
Current Grades All <Al Current Grades:=
Student Attributes all <all Student Attributes =
< Back | Next = | Cancel | Print Prewview Lapout

11. Inthe Include column, select “All” or “Selected”.

If you choose “Selected”, the Selected screen appears. You can select the filters to create the student
profile report. Make your selections and click OK. You return to the Filters tab, and the filters appear in
the Selected Filters column.
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12. Click Next or select the Format tab.

I3 New Student Profile Report x|

File Edit | Wiew Favorites Tools Help

dasaw al= 2- |

1 Generall 2 Filters 3 Format |

B Headings Headin gs
Criteria

Sart —Heading Faormat
Page Footer Title: IStudent Frafile Repart
Fieport Footer St I

Miscellaneous
Aligr: ICenter Yl

¥ Piint arganization name in header

¥ Print Page Mumber in Heading [V Frint Feport Date in Heading
Format: IF'age 1 j Format: IShort Date and Time j
Aligr: IHight j Aligr: ILeft j

¥ Piint report heading on each page

< Back | et > | Cancel | Frint | Presvigw | Lapout

Note: In the Title and Subtitle fields, you can enter up to 60 characters.

13.
14.
15.
16.

17.

In the Title and Subtitle fields, specify the heading to appear at the top of the report.
In the Align field, select “Left”, “Center”, or “Right” to select the heading alignment.
To print your organization’s name in the heading, mark Print organization name in header.

In the Print Page Number in Heading and Print Report Date in Heading frames, select whether and how
to show the page number and report date in the heading.

To print the heading on each page, mark Print report heading on each page.



18. In the list on the left, select Criteria.
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I New Student Profile Report
File Edit

d

Wigw  Faworites  Tools

BB a|=[2-

Help

1 Generall 2 Filters  3: Format |

[v Print theze criteria on Ia zeparate page 'l

. Sort

Page Footer
Feport Footer
Mizcelaneous

Saved report name

Report zections o include

Report details to include

Show ending balance as of

Show year-to-date information as of

Students to include

Student attibutes to include

Current grades to include

Billing statuzes to include

Reduce balance by uhgenerated financial aid
Reduce balahce by unhgenerated advance deposits

< Back | et » | Cancel | Print | Presvigw |

Lapout |

19.

To print a list of the criteria you used to create the report, mark Print these criteria on and select “a

separate page” or “the first page”. The program automatically selects all criteria to be printed.

20.
21.

To deselect any criteria from the list, unmark its checkbox.
In the list on the left, select Sort.

I3 New Student Profile Report
File  Edit

dadam - -

Wiew Favorites Tools Help

1 Genelall 2 Filters 3 Format |

Headings
Criteria

Sort

B Sort Sort by I

Order by I

Page Footer
Report Footer
Miscellaneous

Student I Ascending

[ Page break on each new Student D

< Back | et » | Cancel | Frint | Previgw |

Layout |

Note: If you do not select a sorting category in the Sort by column, the program automatically sorts by the

student name in ascending order.
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22. To select the order in which information appears on the report, select a sorting category in the Sort by
column and then select “Ascending” or “Descending” in the Order by column.

23. To print each sorting category selected in the Sort by column on its own page, mark Page break on each
new.

24. In the list on the left, select Page Footer.

A& New Student Profile Report x|

File Edit Mew Favorites Tools Help

dagamal=?- |

1 Generall 2 Filters  3: Format |

Headings Page Footer

Criteria ST

St ~ Page Footer Tex
‘B Page Footer Text:
Report Footer
Mizcelaneous

Align: I Center ¥ l

[ Print Page Mumber in Footer ———— [~ Print Report Date in Footer —————
Farmat: IF'age 1 j Farmat: IShort Drate and Time j
Aligre [Fight = | | s [Len =

< Back | Hest = | Cancel | Frint | Preview | Layout |

Note: In the Text field on the Page Footer Text frame, you can enter up to 254 characters.
25. Inthe Text field on the Page Footer Text frame, specify the footer to appear at the bottom of each page.
26. Inthe Align field, select “Left”, “Center”, or “Right” to select the footer alignment.

27. Inthe Print Page Number in Footer and Print Report Date in Footer frames, select whether and how to
show the page number and report date in the heading.



28. In the list on the left, select Report Footer.
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I3 New Student Profile Report

File Edit Wew Favorites Tools Help

dadag ol -

1 Generall 2 Filterz ~ 3: Format I

‘8 Feport Footer
Miscellaneous

Aligri I Left - I

Headings Report Footer
Criteria B
Gt eport Footer Tex
Page Foater Test:

< Back | Hext = | Cancel |

Print | F'leviegl Layout |

Note: In the Text field on the Report Footer Text frame, you can enter up to 254 characters.

29. Inthe Text field on the Report Footer Text frame, specify the footer to appear at the end of the report.
30. Inthe Align field, select “Left”, “Center”, or “Right” to select the footer alighment.

31. Inthe list on the left, select Miscellaneous.

I New Student Profile Report x|
File Edit Yiew Favoriies Tools Help
FIEEEEEETRE |
ilE Generall 2 Filkerz 3 Format |
Headings Miscellaneous
Critetia
Sark Shows currency character on Al armaunts
Page Footer Show percent sign on all amounts
_ port Footer Megative amount format (1234.56)
LI WS Mumber of digits after decimal For amounts 2
Mumber of digits after decimal For percentages 2
Show 1000's separator Yes
Shows blanks instead of zeros Mo
Font size g
Sample amount;
Amount ($1,234.56)
Percent 100.00%
< Back | st > | Cancel | Print | Preview | Layout

32. Specify how numbers will appear on the report and select the font size.
33. To view the layout of the report, click Layout. A Student Profile Report layout appears.
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34. To preview the report, click Preview. A Student Profile Report appears.

35.

To print the report at the default printer, click Print.

» Opening an existing student profile report

1.

From the Reports page in Student Billing, click Student/Individual/
Organization Reports. The Student/Individual/Organization screen appears.

[ Thie Fimvanc el Feliges {Samaplie Dk} =1l x|
Fle [t Wew Go Fgvorkes Jook Help

Community Services Inc. =+ Student Billing
13 Reports - Student/Individual/Organization Reports
| Hew Opgen (el

1111 Acesonart Bakar R Student Profile Report
121 Fatiy Diectony

[] Irsckacdual Frotie Fepos |Descripton  Date Created  [Crested By | Othrers May Moy | Cthers May Execute
4 Cugerization Profie Flepon | [ 3[SP005  Supervisor
[7) Paymert Riesporshiity Riepor

111 1 Fiscord S1atistics Repot

In the list on the left, select “Student Profile Report”.

In the grid on the right, select the Student Profile Report to print. To create a new Student Profile Report,
see “Creating a new student profile report” on page 46.

Click Open on the action bar. The report screen appears.

I3 Student Profile ; X

Eile Edit Miew Favorites Tools Help

dadam = ?- |

1: General | 2 Filtersl & Formatl

Show these report sections: Show these details:

[¥ address Information - [¥ 55N -
[V Addressess/S alutations [V Mickname

¥ Relationships [V Current grade

[¥ Enmoliments [¥ &dvisor

[ Account Summary [¥ Homeroom teacher

¥ Bill Codes [V Homeroom

¥ Finanrial &id =l | pith dete. id.

[~ Show ending balance az of -
Az of date; ITDda-"J vI 101142005

[T | Beduce balance by ungenerated financizl aid?

™| Beduce balance by ungenerated advance deposits?

Show pear-to-date information a3 IThig fiscal year vl 0740142005 ko 12431 ./2005

[~ Create an output query of students

Feport arientation: I Partrait - l

< Back | Mesxt = | Cancel | Print | Frewview Layout

5. To preview the report, click Preview. The report appears.

6. To print the report at the default printer, click Print.
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» Editing a student record
1. From the Records page in Student Billing, click Students. The Students page appears.

B The- Finanwial Edge
Ll Gt ¥iew Go Fyeorkes Jooks b
+ Back | Camemunity Sarvices inc. -+ Sudenk Billing =

B Records = Students

. =] | mecords |
[ What do you want to do? Prodxts |
x el |
4 ; . [
@ Ak 3 Naw Shadent Iﬂ@ Copy Shudent Information Sk |
- ELmna::mm %Mmagecllnga [t
i oups Orgactazen |
'g f it opticns for Studants Charges |
! " i Rafunds I
glw . Search for a Student by Student name Ceposts |
 — Paymerks |
‘.r’;l L] Advance |
| 8 Deposkts |
i Access a Recently used Student w I
Hurker ddans. 1
nfigurstion it s |
D, st Fushiey Fickdeton

=

Find: IStudent j Search uging query: |<Default> ml{;l

L (L= ﬁ Add a

at meet t eria; : natch only
Last namme: || j City: I j
First name: I j State: I j
Student 1D: I j ZIP: I j
Mickname: I j E xclude inactive? IYES j
Billing status: I j D ocument 3#: I j
Current grade: I j Lazt modified by: I j
SSM: I j Last madified o Ian_.,. e j
- Hide Fileers | Clear Filtersl Previous Filtersl Filters are not applied Find Mo I Dpeti | Canicel |

|Press F7 to zoom

In the Find Students that meet these criteria frame, enter the criteria to use to find the student.

After you enter the search criteria, click Find Now. The program searches the database, and all records
that meet your criteria appear.

Select the student record to open.
Click Open. The student record appears.
Make changes to the student record.

© N v

To save the changes to the student record and return to the Students page, click Save and Close.



54 CHAPTER




blackbaud

chapter 5

Payroll End of Year

2016 Year-ENd TaX Changes .. ....ciiiiitiiiie e ieeeenarenseesneesaseasensassnssnsansensnnnnns 56
W-2 Reporting and ProCessing . ... ..vutintintnetnteteneeneensoeeaeensansansassasensansansannns 57
Printing Employee Profiles . .. ... e e 57
Verifying W-2 AMOUNES. . oottt e e et e e e e e 57
Correct W-2 BOX AMOUNTES . ..ottt et e e et e e e e 58
Creating and Processing W-2s . ... ittt et e et et e e e e e 58
Preparing for the First Payroll of the New Year. . .. ... ..ottt i it ittt tearannannnannns 65
Create Your Pay Schedules . ... ... i e e e e 65
Tax Table Changes . . . ..ot e e e et et et e e e e 67

Create a Federal and State Tax Table ... ..ottt e e e e e i e e 67
Update Employee Information. . .. ... i e ettt e e e e e 68

P Y YRS . vttt e e e e e e e 68

Benefits and DedUCIONS . . ...ttt e e e e e 68

EMpPloyee Changes . ..o e e e e e e e e 69
I Q8 3T + Lo T o 70
Registering TaX REPOIES. . .ottt et e e et e et e et et e e e 70
) = L I T (=T 0T ] o P 71
Federal TaxX REPOITS. . o\ttt ittt e e e et et e e e e e e 74
Updating TaX REPOITS . .ottt et e et et et et e e e e e e 76
EFIlING TaX REPOIES . oottt e e e e e e e e e 77
TaX RePOIt HistOry . . oot e e e et e e e e e e e 78
TaX AdJUSEMEBNTS .. ..ttt i ittt ittt eeeeseeeneeeneaneaneoaseseensansansassnsansansanennsnsas 80
Frequently Asked QUeStIONS . . .. ...ttt iit it ittt tietenrerenennennsansonsnassnsensaneansnnnnns 81

Additional ENd-0f-Year RESOUICES ... v v v ittt it ieeeteenneeeeeeesnnassesesnsnssssensnnssssennes 82



56 CHAPTER

This chapter includes a sample end of year process, information about getting ready for the first payroll of the
new year, and procedures for making tax adjustments. These sections are not in any particular order. For
example, you might run your first payroll before running W-2s and vice versa. Although Payroll does not have a
difficult year-end close, you must consider a few things before you calculate payroll for the new tax year.

Note: Blackbaud offers quality forms, pre-printed in color with your organization’s logo and information. For
details, call 866-4-BB-Forms, visit http://forms.blackbaud.com, or send an e-mail with questions to
forms@blackbaud.com.

You can run W-2s at any time, even after you begin processing payroll for the next year. The program keeps the
tax years separate based on check dates. Consequently, you do not have to print W-2 forms before processing
payroll for the upcoming year.

The table below illustrates a sample end-of-year process for Payroll. This is an example only. Your time frame and
the dates of certain functions may be different.

Sample End of Year Process Date complete:

Process the last payroll of the new tax year. Before finalizing |December 24
this payroll, we recommend you review YTD reports. It is a
also good idea to print and review a W-2 test run, so you can
make any necessary tax adjustments resulting from
incorrect tax flag settings.

Update all relevant tax tables with rate or other changes for |January 5
the new tax year. Update all employee records for changes
in pay, deductions, etc.

Process first payroll of the new year. January 12
Print a W-2 test run to verify accuracy of information. January 15
Print W-2 forms and distribute. January 16
Process second payroll of the new year. January 26

2016 Year-End Tax Changes

Your Financial Edge program has been updated to accommodate 2016 tax changes, which include updated
defaults for tax tables in Payroll. While we do our best to ensure this information is accurate and up-to-date with
the latest guidelines, it is your responsibility to verify tax table information and to make any changes required by
Federal or State governments at the time they become effective.

If the tax tables have changed, you can add a new tax table and specify the date when that tax table will become
effective. You can find tax table information in the Circular E (obtained from the IRS at www.irs.gov) and state or
local publications. Editing the tax tables will not affect historic calculations.

MISC-1099s and eFiling

Instead of processing your 1099s directly through Mail in Accounts Payable, you can now connect to Aatrix. The
Aatrix integration combines your data with their content to populate the integrated reports in compliance with
state and federal tax agency regulations. The 1099-MISC and W-2 eFiling solutions provide a range of choices
from a complete full service eFiling option to a partial eFiling of just the federal forms, state forms or both.

While we recommend using the complete eFiling option as a best practice, you could skip the eFiling option
altogether and print to paper tax forms. Please be aware, there are costs associated with eFiling. Also the new
option to eFile 1099-MISC forms impacts your decision whether to purchase paper tax forms. To purchase
compatible preprinted paper tax forms for paper or the partial eFiling options, please contact the Blackbaud
Forms team at 866.422.3676 to speak to one of our trained tax forms specialists.
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W-2 Reporting and Processing

With Payroll, you can begin processing payroll checks for the new year even if you have not yet printed W-2s for
the current year. However, before processing the first payroll for the new year, make all necessary changes to
employee records regarding pay types, benefits, and deductions.

Note: Editing the tax tables will not affect historical calculations.

We also recommend you verify that tax tables are correct for the coming year. If the tax tables have changed, you
can add a new tax table and specify the date for that tax table to become effective.

Tax table information can be found in the Circular E (obtained from the IRS) and state or local publications. You
will want to remember to pull the information from the Annual tax table.

You can download the Circular E, MMREF-1, and specifications for filing various tax forms, from www.irs.gov.

Printing Employee Profiles

To verify employee biographical information, you can run the Employee Profile Report. We recommend you run
this report to ensure all employee data, such as address and Social Security Number, has been entered correctly.

Having employees verify their biographical information prior to running W-2 forms can save time and avoid
delays. Employees can make their corrections directly on the report and return them to the Payroll
Administrator. When running the Employee Profile Report, you can choose to print each employee on a separate
page.

For more information about creating the Employee Profile Report, see the Reports Guide for Payroll.

Verifying W-2 Amounts

Once the employee biographical information has been verified, you should begin reviewing the figures that will
appear on the W-2. You can print the W-2s to plain paper to verify the amounts (see “Creating and Processing
W-2s" on page 58). The Adjusted Gross Wage figures that are calculated on each payroll check will be

accumulated by the program and will appear on the W-2. Before you process the actual W-2s, it is critical that you
check these figures.

The following table shows where the adjusted gross figures, accumulated on each payroll check, will appear on
the W-2:

Taxable Gross W-2 Box
Federal Box 1
Social Security Box 3
Medicare Box 5
State Tax Box 16
Local Tax Box 18

The table below displays the report(s) you can produce to check the figures printed on the W-2. This table is
based on the 2005 W-2 form. Any IRS changes to the W-2 form for the coming year could cause this listing to
change.

W2-Box Payroll Reports
1,3,5,616and 18 Adjusted Gross Wage Report
2,4,6,17 and 19 Deduction Profile
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W2-Box Payroll Reports

9,10, 11and 12 Deduction Profile or Payroll Register

14 Located on the Employee record, Tax
Settings tab, W-2 option

13 Located on the Employee record, Tax
Settings tab, W-2 option

15 Located on the Employee record, Tax

Settings tab, State Income Tax
Settings option

21 Localities are defined in
Configuration, Tax Tables, Local Taxes

a Entered on the parameter screen
when printing W-2s

b Specified in Configuration, General
page

C Specified in Configuration, General
page

d Employee record

e Employee record

If you find discrepancies in the employer information, check the General page in Configuration for the Federal tax
ID and the employer address. The state tax identification number is on the Taxes page in Configuration. General
employee information, such as name and address, is on the employee record.

Correct W-2 Box Amounts

Incorrect amounts on W-2s can be corrected using historic entries or adjustments made to the last paycheck of
the year. The type of adjustment needed depends on the W-2 box requiring correction. Refer to our interactive
W-2 Wizard, which takes you step-by-step through the process of making adjustments using Historic Entries. You
can adjust the following boxes using either a Historic Entry or on the next paycheck, if one remains in the
calendar year of the W-2:

¢ Federal taxable wages (W-2 box 1): BB318905

¢ Federal tax withholding (W-2 box 2): BB264842

¢ Social Security (FICA) taxable wages (W-2 box 3): BB351986
¢ Medicare taxable wages (W-2 box 5): BB586119

Creating and Processing W-2s

Note: The W-2 Setup Wizard will prompt you for company information, W-2 control numbers, and W-3
information. Make sure you have this information available.

In Payroll, you can use State and Federal Tax Reports to produce copies of W-2s for employer and employee
records and for filing with the Social Security Administration and state agencies.

For eFiling, you must submit your W-2s at least two days before the state or federal deadline to allow for Aatrix
processing. For more information about Aatrix, see https://efile.aatrix.com.

Creating W-2s is similar to the process of creating other types of reports and mail. You can view, edit, save, print,
or eFile W-2s.


http://www.blackbaud.com/support/faqs/w2.aspx
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Each W-2 copy has different printing requirements. From the action bar of the W2 Preparer, you can select each
copy:

W2 Report. Generates a W-2 Summary Report
Fed Copy. Generates report data to the official Copy A, or RED copy, for the Social Security Administration

Employee Copy. Generates the four employee copies of a W-2: Copy B for the employee’s federal return; Copy
C for the employee’s records; and Copies 1 and 2 for state, city, and local tax filing

Employer Copy. Generates Copy D for the employer’s records

Employee Notice. Generates the Employee Notice, a text-only notice from the government with information
on filing returns, explanations of the boxes on the W-2, and instructions for filling out a Federal income tax
return

State Copy. Generates copies of the employee’s W-2 for the states you select, if a state requires you to file a
copy

Form W-3. Generates the report data to the official Form W-3, the fiscal year total wage and tax statement for
your business, which must be filed with the Federal RED Copy A for W-2 to the Social Security Administration

» Creating W-2s

Note: The first time you click State and Federal Tax Reports in Mail, a message appears asking if you want to
install State and Federal Tax Reports. Click Yes and the program installs automatically. For more information
about registering for tax reports, see “Tax Reports” on page 70.

1. From the Mail page in Payroll, click State and Federal Tax Reports or select the State and Federal Tax
Reports tab. The State and Federal Tax Reports page appears.

[ The Financial Edge HEE
Fille Edit “iew Go Favortes Toole Help

€ Back % Eaiivand ] Cormrmunity Services Inc, + Payroll

% Mail - State and Federal Tax Reports

Shartcuts

Mew Oper Delete,.. |Mai|

State T State and
B State TaxRepoits State Tax Reports Federal Tax
Federal Tax Reparts Reports

MName |Des:npt|0r| |Dats Created Tas: Report
Histary

L] | Il

™ Only show my reports

State taw reparts prints wage and tax information retums including state
=i Helo withholding returnz, unemplayment returns, and new hire reports.

Blackbaud Systems |

Welcome to Payioll
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2. Inthe list on the left, select Federal Tax Reports and click New on the action bar. The New Federal Tax
Reports screen opens on the General tab.

A3 New Federal Tax Reports x|

File Edit Yiew Favorites Tools Help

|| «|=?-

1: Gerneral |g: Filtersl

Select the federal report you want to create

Report Mame: IW-2_SSA j

Descriptior: |lge this form to process Ws

Feporting Period: IFuII year 'I

[~ Create an output query of employees

< Bach | Hext > | Cancel | Qispla_l,lF!eportl

3. Inthe Report Name field, select “W-2_SSA”. The Description box displays “Use this form to process W2s”
and the Reporting Period field displays “Full year”.

In the Year field, select “This year” or “Last year”.
To create a list of employees included in the report, mark Create an output query of employees.
6. Click Next or select the Filters tab.

N New Federal Tax Reports x|

File Edit \Miew Favorites Tools Help

dl o= - |

Filkers | Include Selected Filkers |
Employess all <Al Employees >
Emploves Statuses all <Al Emplovee Statuses >
Departments all <Al Departments =
Emploves attributes all <Al Emplovee Attributes =

¢ Back et » | Cancel I Dizplay Report |
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7. In the filters grid, you can filter the employees or departments for whom you want to process W-2s. To
create W-2s only for specific records, select the records, a range of records, or a query of records. For
more information about filtering, see the Program Basics Guide.

Click OK. You return to the Filters tab.
8. From the menu bar, click File, Save. The Save Mailing as screen appears.

Save Mailing as ; x|

M ailing name; |

Description:

¥ Others can run thiz maiing
[ Others can modify this mailing

[ save | Cancel |

In the Mailing name and Description fields, enter a name and description for the mailing. Mark whether
others can run or modify the query and then click Save. You return to the Filters tab.

9. Click Display Report.

Note: If a mandatory or optional quarterly update is available, the Update screen appears. To continue
processing, click Yes. At the Aatrix Update Client — File Selection screen, click Check All, then Next, and then
Finish.

10. If you marked Create an output query of employees on the General tab, the Save Static Query screen

appears.
Save Static Query 5'
Luery name: | u Save |
Description: |Aatriz Employees ;I Cancel |

Cluery format; IStatic vl Created From: Aatrix Employess

¥ Others can iun this query
¥ Others can modify thiz queny

In the Query name and Description fields, enter a name and description for the query. Mark whether
others can run or modify the query and then click Save.

Note: Starting a new Draft file replaces the existing data in the previously saved file with the new W-2 data
you enter.

11. If you previously saved a copy of your W-2s, the Draft File Found screen appears. To continue working in
your previously saved file, mark Open it. Otherwise, mark Start a new Draft file.

Draft File Found

& Diraft file containing 'W-2 data for this compary has
been found. “What do you want to do with thiz file? —

Cancel |
{* Openit

" Start a new Draft file,

[This option replaces the existing data in the
Drraft file with new -2 data.]

Click Continue.
¢ If you mark Open it, the TO PROCESS W2s screen appears. Go to step 22.
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12.

13.

Note:
W-2s.

14.

15.

Note:

¢ If you mark Start a new Draft file, go to step 12.
A message appears.

*“ou may need Help to go through the Y2 process.

It you click Help now, you can review the Help as you
proceed.

ok | Hep |

To review Help screens for the W-2 Setup Wizard as you proceed, click Help. Otherwise, click OK. The
Form W2 Setup Wizard screen appears.

If you clicked Help, the W2 Preparer Help screen appears behind the Form W2 Setup Wizard screen.

Make sure you have company information, W-2 control numbers, and W-3 information available. At the
Form W2 Setup Wizard screen, click Next. The Control Number screen appears.

The Control number in Box a on a W-2 is optional. You can use Control numbers to identify individual

Mark what to print for control numbers on the W-2s:
¢ Don’t print Control numbers — Leaves Box a on the W-2 blank.

¢ Print Control numbers starting with — Assigns control numbers to each W-2. Enter the starting number
for the control numbers, such as “001”. To start the control number with the first three letters of the
employee’s last name, mark Prefix with first three letters of employee last name (e.g., LUN-081).

¢ Print the Employee ID numbers as Control numbers — Prints the employee identification number as
the control number if your employees already have identification numbers.

Click Next. The Company Information screen appears.

All fields in the Company Information frame, except Trade name, Address line 2, and Fax #, must be

completed.

16.

17.

Note:

In the Company Information frame, verify the information is correct and complete any required fields
that are blank.

The State Information grid lists the tax states you have set up and used in Payroll, and the State ID
number for each state. Verify the information is correct. To make changes to this list, click Edit.

The States shown in the Locality Information grid depend on the states selected in the State

Information grid.

18.

19.
20.
21.

The Locality Information grid lists:

¢ Locality — The name of the city, county, school district, or other taxing locality
¢ Type — The tax type code for the locality

¢ State — The state in which the locality is located

The program automatically links most items. However, some items may need to be linked manually. To
change the tax type code and state for a locality, click Edit. To add a new locality, tax type code, and state,
click New.

If the business ended in 2004, mark This business was terminated in 2004.
Click Next. The W3 Information screen appears.
Enter information in the fields as applicable:

¢ Box a - Control # field — This field is optional. Enter a control number to be used for numbering the
whole transmittal.
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¢ Box b - Kind of payer field — This field is required. Select the kind of payer from the submenu: “941”,
“943”, “CT-1", Household employee (“Hshld. emp.”), Medicare government employee (“Medicare govt.
emp.”), or “Military”. If the payer pays third-party sick pay, mark Third-party sick pay.

¢ Box d - Establishment # — This field is optional. Enter an establishment number to identify separate
establishments in your business.

e Box h - Other EIN used this year — If you used an Employer Identification Number (EIN) on Forms 941,
943, or CT-1 submitted during the update year that is different from what is reported on the W-3, such
as a prior year’s EIN, enter that EIN.

¢ Box 14 - Income tax withheld by payer of third-party sick pay — If you have employees who had
income tax withheld on third-party payments of sick pay, enter the amount.

22. Click Next and then Finish. The TO PROCESS W2s screen appears.

Note: You can access the Help screens for the W2 Preparer at any time. To access the Help screens, click Help
from the menu bar.

23. Click OK. The W2 Preparer screen appears.

24. The columns in the left section of the grid include the employee’s biographical information such as name,
address, and employee ID number. The columns in the right section of the grid include the employee’s
wage and tax information. To see more of either section, place your cursor on the gray bar between the
two sections until the arrows appear, and then click and drag the gray bar to the left or right to increase
the visible area of the section.

Note: You must adjust the Employee record or the activity will not match the W-2. We recommend making
changes to the Employee record before preparing W-2s.

25. Review the information in the grid. If necessary, you can edit or add W-2 information. Changes made to
this screen are not written to the Employee record. You must adjust the Employee record or the activity
will not match the W-2. We recommend making changes to the Employee record before preparing W-2s.

26. To revise the company information entered on the W-2, click Company on the action bar. The W2
Preparer Settings screen opens on the Company Information tab.

Revise the company information and click OK. You return to the W2 Preparer screen.

Note: If you do not know what data columns are linked to which boxes on the forms, see the instructions that
came with your W-2 or Form W-3, or download them from http:\\www.irs.gov.

27. The program automatically links most data columns and boxes. Verify the program correctly linked the
data columns to boxes.

¢ Data columns with green headers indicate the payroll item is already linked to the appropriate W-2 box.
Green column headers are locked and cannot be edited, although you can change the data in these
columns, such as to correct a misspelled word or an incorrect dollar amount.

¢ Data columns with red headers indicate the payroll item requires manual linking. You can edit the titles
of these headers. To manually link the data columns to the appropriate boxes, select the box to which
the data must be linked from the column’s submenu. As the data columns are linked to boxes, the red
headers will become green.

Note: If a data column is not linked to a box, its data is not printed or displayed on the W-2 or W-3.

28. Some of the data columns may be undefined. To link undefined data columns to boxes, click on the
header of the data column. From the submenu, select the box to which the data must be linked.

Note: Itis essential that you print and review your data. You may think an on-screen scan of the data is
sufficient, but mistakes are often easier to see on paper.
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29. After you verify all data is correct and linked, you can print and review the W-2 Summary Report that lists
all the employees and their W-2 information on plain paper.
» Processing W-2 copies from the W2 Preparer Screen

1. From the action bar of the W2 Preparer screen, click the copy of the W-2 to process. For example, to print
a W-2 Summary Report, click W2 Report on the action bar. A Verification of Links message appears.

Note: Clicking OK signifies that you have verified the data and links are correct. Neither Aatrix Software nor
Blackbaud is responsible for errors on forms submitted to the government. If you have not verified the data,
click Cancel.

2. To confirm you have double-checked and linked the data, click OK. A Report Steps message appears.
Click OK. The W-2 Summary Report screen appears.
From the action bar, click Print. The Print screen appears.
In the Preferences frame, select the paper source, number of copies, and page range to print.
In the Printer frame, in the Name field, select a printer.

No UV W

If this is the first time printing a form on this printer, or if you have changed printers, click Page Align. The
Page Align screen appears.

Click Print Alignment Form and Print Test Page. Refer to the printed alignment form to align the Test Page
as necessary and then click Done. The Print screen appears.

Note: Clicking Agree signifies that you have verified the data is correct. Neither Aatrix Software nor Blackbaud
is responsible for errors on forms submitted to the government. If you have not verified the data, click Double
Check.

8. Click OK. The W-2 Summary Report prints on the printer you selected.
9. Review the printed W-2 Summary Report.

If the W-2 Summary Report is not correct, click File, Exit on the menu bar and then click No. The W2
Preparer screen appears. Make changes as necessary and then return to step 1.

If the W-2 Summary Report is correct, click Save and then Next Step on the action bar. The Verify Report
Complete message appears.

10. To confirm you have double-checked the data, click Agree. The W-2 Summary Report screen appears.

11. To print a copy of the W-2 Summary Report for your records, click Print and then Next Step on the action
bar.

Note: You can eFile your report information with the Aatrix eFile service. To eFile, you must be registered for
this service. For information about enrolling for eFile, see “Enrolling in eFile” on page 77.

12. To mail a certified copy to the federal agency, click Print. Otherwise, click eFile and then see “eFiling a
report” on page 78.

The Processing Complete message appears.
13. Click Yes. The W2 Preparer screen appears.
14. To process another copy, go to step 1.
15. When all W-2 copies are processed, click File, Save on the menu bar to save the W-2 information.
16. From the menu bar, click File, Exit to exit the W2 Preparer screen.

» eFiling a W-2 from the W2 Preparer Screen

You can eFile your report information with the Aatrix eFile service. To eFile, you must be registered for this
service. For information about enrolling in eFile, see “Enrolling in eFile” on page 77.

1. From the action bar of the W2 Preparer screen, click eFile.
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If you have already signified you have verified the data and links, the Aatrix eFile — Login screen appears.
Go to step 6.

Otherwise, the Verification of Links message appears.

Note: Clicking OK signifies that you have verified the data and links are correct. Neither Aatrix Software nor
Blackbaud is responsible for errors on forms submitted to the government. If you have not verified the data,
click Cancel.

2. To confirm you have double-checked and linked the data, click OK. The eFile screen appears.

3. Inthe eFile Options frame, select which copies to file. The Forms that will be submitted field lists the
copies that will be filed.

4. Click OK.
5. If you selected All, Fed/State, or State in the eFile Options frame, the State List screen appears.

Select the state to which you are submitting copies of the employees’ W-2s. To select all states, click
Check All. To select no states, click Check None.

After you select the state, click Continue.

6. The Aatrix eFile - Login screen appears. For more information about eFiling, see “eFiling a report” on
page 78.

Preparing for the First Payroll of the New Year

To prepare Payroll for the new tax year, verify or update the tax settings on Pay Types, Deductions, and Benefits
pages in Configuration. We also recommend you review employee records that have any changes to their tax
settings. You can make changes to the tax tables even if you have not printed W-2s for the current year.

Create Your Pay Schedules

Employees’ pay types, benefits, and deductions will not calculate in the new year unless a new pay schedule has
been created. We recommend using the same schedule ID for consecutive years, so the default schedule on
employee records updates automatically.

Note: If you calculate attendance based on pay period, you must use the same schedule ID for each payroll
year.
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» Copy an existing pay schedule
1. In Configuration, click Schedules.

[ The Financial Edge (Sample Data)

fle Edit View Go Favorites Took Help
+ Back + Community Services Inc. = Payroll -
g Home W : II€
‘ﬁ New Schedule Open Delete... Copyfrom... Prit Ewport Find
[T Recoras
i Schecule 1D Calendar Year Scheduie Description Pay Frequency Startingon © | Days per week Hours per day
(@QUE,,. Semi-Monthly 2010 Semi-Monthly Schedule  Semi-monthly 01/01/2010 5 8]
= Weekly 2010 Weekly Schedule Weskly 01/01/2010 5 B
= et Monthly 2010 Monthly Monthly 01/01/2010 5 8
T M Semionthly 2008 Semi-Monthly Schedule  Semi-monthly 01/01/2009 5 8
i Weekly 2008 Weekly Schedule Weekly 01/01/2009 5 8
lg Reparts Manthly 2009 Manthly Monthly 01/01/2009 5 E
Semi-Monthly 2008 Semi-Monthly Schedule  Semi-monthly 01/01/2008 5 8
g vail eekly 2008 Weekly Schedule Weekly 01/01/2008 5 3
Monthly 2008 Monthly Monthly 01/01/2008 5 E]
] Semi-Monthly 2007 Semi-Monthly Schedule  Semirmonthly 01/01/2007 5 8
ﬁh B weekly 2007 weekly Schedule Weskly 01/01/2007 5 s
Monthly 2007 Monthly Monthly 01/01/2007 5 8
Semi-Monthly 2006 Semi-Monthly Schedule  Semi-monthly 01/01/2006 5 3
Weekly 2008 Weekly Schedule Weekly 01/01/2006 5 3
Monthly 2006 Monthly Monthly 01/01/2006 5 8
Semi-Monthly 2005 Semi-Monthly Schedule  Semi-monthly 01/01/2005 5 8
ey 2005 Weekly Schedule weekly 01/01/2005 5 E
Monthly 2005 Monthly Monthly 01/01/2005 5 8
Semi-Monthly 2004 Semi-Monthly Schedule  Semi-monthly 01/01/2004 5 3
Weekly 2004 Weekly Schedule Weekly 01/01/2004 5 E]
Monthly 2004 Monthly Monthly 01/01/2004 5 8

2. Highlight the schedule to copy and click Copy from.
3. Onthe New Schedule screen, make your changes.
4. Click Save and Close.

» Add a new pay schedule
1. In Configuration, Schedules, click New Schedule.

E New Schedule rg‘
File Edit View Schedule Favorites Tools Help
[ Save and Closs - | (= H 4 » M|z 4 ?-
Schedule D | =] vear [2003 =l Period EndDate | SUTAWeeks = Days | Hours®
i 1
Description: =
P [ B
i L =i |8
Pay frequency: | Monthly ~ | MNumber of periods: | 12 o=
4
Starting on: 01/01/2009 T
Hours per daw: [8.00 16]
7
Days per week: |5.00 ?
i Ewvery ’7 ’7 2
10 -
& Evey 1 monthlslonthe [last  «| |Day - < o
12/04/2008

Enter a schedule ID, description, and year.

In the Pay Frequency field, select how often to issue payments.

In the Number of periods field, select the total number of pay periods for the year.
In the Starting on field, enter the earliest possible period end date.

In the Hours per day field, enter the number of hours an employee works per day.
In the Days per week field, enter the number of days an employee works per week.

O N oA wWN

Click Update grid and then click Save and Close.
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Tax Table Changes

You can edit the existing tax tables to reflect tax changes for future periods. However, for audit trail purposes, we
recommend you add new tax tables that reflect the changes to the taxes. If you add new tax tables when the
amounts or percentages change, you can check historical calculations against the tax tables that were applicable
at the time.

To load updated tax table defaults, you must create a new tax table for the upcoming tax year and then restore
table defaults. To do this, access the Tax Tables tab in Configuration and create a new state or federal tax table.
To load the updated defaults, access the Federal or State menu and select Restore Defaults.

Create a Federal and State Tax Table

When you install the end-of-year update, federal and state tax table files are updated based on changes
submitted to Blackbaud before November 30. Because tax changes can be made after this date, we strongly
recommend verifying your tax tables match the annual tables of the Circular E (PDF) to ensure accuracy.

After you’'ve installed the end-of-year update, you’re ready to create your federal and state tax tables. When you
create the new tax tables, the rates default based on the updated values in the tax table file.
» Create a federal and state tax table
1. In Configuration, click Taxes.
2. Select “Federal taxes” or “State taxes” from the Tax type drop-down list.
3. Click New Tax.

83 Add Federal Tax Settings
File Edit View Federal Favorites Tools Help

[ Save and Close - | (= N 4« » W= (™| ?-
Description: | Effective as of: |1,/1/2009
Wendor for remittance: | @
Federal Income Tax | Social Securty Tax | Medicare Tax | FUTA Tax | Advancs EIC |
Pay stub [D: | GL Distribution

Supplemental '\ /H rate:  |25.0000
Daily annualization factar: |260
Deduction per exemption: |$3,650.00

Wage Over

""" $2,650.00 10,0000
$10,400.00 15,0000

$35,400.00 25,0000

$84,300.00 28,0000

§173,600.00 33,0000

$375,000.00 35,0000

12/04/2009

Enter an effective date.

Complete the description and other required fields.

Click GL Distribution on each tab to enter withholding, liability, and expense accounts.
Click OK and then click Save and Close.

N o u s
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Update Employee Information

With the new year comes potential changes to pay types, benefits, deductions, or tax declarations. Verifying this
information is updated and correct will help ensure a smooth first payroll run in January.

Pay Types

Pay type records define the pay rate or amount for regular, overtime, special, and other pay types. You can create
pay types for many varieties of employee compensation, including salary, hourly, overtime, and bonus pay. When
you pay employees, you can do so according to the default schedule, or you can select specific dates.

Benefits and Deductions

There are two options to update benefits and deductions depending on how many records need to be updated.
For changes specific to each employee, use the Change Compensation Wizard.

If you need to make the same change for a large number of employees, use Create Group Assignment. This
option allows you to select employees using filters to update all records at the same time.
» Change Compensation Wizard
1. In Records, Employees, open the employee record.
2. Select the Compensation/Deductions tab and click Change Compensation.

I® Change Compensation Wizard

What do pou want to do? ’m
Pay Type D | LIQI
[v Expire this Pay Type | j Effective end date: ’7
i —
,7
()8 | Cancel |
12/04/2009

3. Inthe Change Compensation Wizard, select Copy Existing [compensation type].
In the ID field, click the binoculars and select a compensation type to copy.
Note: You must select a compensation type currently assigned to the employee.

5. Mark the Expire this [compensation type] checkbox and enter an effective end date.
6. Mark the Increase/Decrease [compensation type] using checkbox and enter an amount.

Note: To increase the [compensation type], enter a positive number. To decrease the benefit, enter a negative
number.

7. Click OK. The new compensation type will become effective the day after the existing compensation type
expires.
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» Create Group Assignments

1.

In Payroll Processing, click Create Group Assignments.

™ Group Assignment E@@

File Help
e

Step 1: Options ‘2 Fitters } 3: Assignment Gri\:l]

What do you want to do? |Asswgn new recards to employees j

Assign new: | j

Pay Type ID | L@I

Effective date: | ﬂ

[ Expire this Pay Type | J Effective end date: ’7

[~ Change the emploves status to:

Include Employees who:
[~ Currently have the record assigned

[ Aue eligible for the record

[ Piint a control repart on: J
[v Cieate output query of records created

[v Create output query of employess who cannot be updated

| = ﬂext) R ‘

12/04/2005

On the Options tab, select Copy existing records onto employees.

3. Select Benefit or Deduction from the Copy existing drop-down list.

Note:

In the ID field, click the binoculars and select a compensation type to copy.

You must select a compensation type currently assigned to the employee.

Mark the Expire this [compensation type] checkbox and enter an effective end date.
Mark the Increase/Decrease [compensation type] using checkbox and enter an amount.

To increase the [compensation type], enter a positive number. To decrease the benefit, enter a negative
number.

Select the Filters tab and define the appropriate filters.

Select the Assignment Grid tab to review the records that will be updated. Depending on the
compensation type and defaults defined, additional information such as hours or amounts may be
required.

Click Process Now and then Yes to confirm the group assignment. The new compensation type will
become effective the day after the existing compensation type expires.

Employee Changes

Verify employees tax settings on the Tax Settings tab of the employee record. Regular pay for employees can
have one of four settings:

¢ Use settings on pay types assigned to employee

¢ Withhold Tax on all pay types assigned to employee

¢ Do Not Withhold or Report Earnings on assigned pay types

e Report Earnings Only - No Withholding on assigned pay types
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It is important that you understand these settings and how they affect withholdings, tax returns, and
employees’ W-2s.

) Davis. Zelda |. _ O]

File Edit “iew Emplopee Favortes Tools Help
ESaveandClosev| n||ﬁ @l H 4 » H |E|6—'d‘||
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Emplopes | HE Info | Activity | GL Distributionl Compenzation/Deductions ~ Tax Settings | Contacts and Addresses

2. \

Federal Tax Settings
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Withholding adjustment; I

Federal Tax Settings
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Tax Reports

In Payroll, you can use State and Federal Tax Reports to produce state and federal reports for withholding taxes,
unemployment wage reports, and new hire reports.

Note: You can download the Circular E, MMREF-1, and specifications for filing various tax forms, from
WWW.irs.gov.

Creating tax reports is similar to the process of creating other types of reports and mail. You can view, edit, save,
print, or eFile tax reports.

Registering Tax Reports

Before you can print or eFile tax reports, you must purchase a registration code. Prior to registering, all reports
are available in demonstration mode. When you print a report, a DEMO watermark runs diagonally across the
page so the report cannot be filed. The demonstration mode allows you to “try before you buy” all tax reports.

If you have an Internet connection, you can register directly from an open tax report. Otherwise, you can call
Blackbaud Support at 1-800-468-8996 to receive your registration code. Once you receive the registration code,
you can enter it on the Registration screen to unlock the reports.

Registration is valid for one year. In the last quarter of your registration, you receive a warning message that your
registration will expire soon. If you have an Internet connection, you can renew directly from the warning

message. If you do not have an Internet connection, you must call Blackbaud Support to receive a renewal
registration code.
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» Registering tax reports using an Internet connection
If you are connected to the Internet, you can register directly from a tax report.

Note: If your computer is connected to a network, you may receive an error message that says: “An Internet
connection failure occurred. Proxy authentication required.” This is related to your network security. You
should contact your system administrator about how to resolve this.

1. From the Tax Reports page in Mail, click State and Federal Tax Reports.

The first time you click the State and Federal Tax Reports link, a message appears asking if you want to
install State and Federal Tax Reports. Click Yes and the program installs automatically.

When the installation is complete, click OK and the User Registration screen appears.

The Company Name and EIN fields display your organization’s name and EIN number as entered in
Payroll Configuration.

In the Contact First and Last Name fields, enter the contact person for tax reporting.

In the Address, City, State, Zip fields, enter the contact’s address information.

In the Phone and Email fields, enter the contact’s phone number and email address.
Click OK to complete the registration and return to the state or federal tax report screen.

vk wnN

» Registering tax reports without an Internet connection

If you are not connected to the Internet, call Blackbaud Support at 1-800-468-8996 to receive your
registration code.

1. To access the Registration screen, click Register on the demonstration mode warning screen that appears
when you access a state or federal tax report, or select Help, Registration from the menu bar of an open
report. The Registration screen appears.

2. The Products Registered to EIN field displays your company’s E.I.N (Employer Identification Number).

In the box at the bottom of the screen, enter the registration code provided by Blackbaud Support and
click Enter.

A list of reports, their report descriptions, and expiration dates appears in the center box.
4. Click Done to complete the registration and return to the state or federal tax report screen.

State Tax Reports

You can create state tax reports for official filing in several formats, depending on the type of report and the
limitations set by state and federal authorities.

» Creating state tax reports

Note: The first time you click the State and Federal Tax Reports link in Mail, a message appears asking if you
want to install State and Federal Tax Reports. Click Yes and the program installs automatically.
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1. From the Payroll Mail page, click State and Federal Tax Reports or select the State and Federal Tax

Reports tab. The State and Federal Tax Reports page appears.
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2. Inthe list on the left, select State Tax Report and click New on the action bar. The New State Tax Reports

screen opens on the General tab.

3. In the State field, select the state to create the report for.
4. Inthe Report name field, select the type of report to create.
5. The Description box displays the description of the report.

6

In the Reporting period field, select the period to include. Depending on the report, additional fields

appear for you to select the quarter, month, year, or range.

7. Mark Create an output query of employees to create a query of employees included in the report.

P
A2 New State Tax Reports
File Edit View Favorites Tools Help

gl o= ?-
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8. Select the Filters tab.

3
2| New State Tax Reports

X

File Edit View Favorites Tools Help
o T
i
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#i0pen
Filters Include Selected Filters
Emplayees All <Al Emplayees =
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Departments All <All Departments =
Employee Attributes Al <All Employee Attributes>
¢ Back | | Cancel | Display Report

9. Inthe filters grid, you can filter the employees or departments to include.
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Note: The yellow status bar at the top of the screen displays which copy of the report you are viewing.

10. Click Display Report. The state report opens to the Review/Edit screen.

Enter date business was registered with the SCESC (MMYY): {]
Enter quarter date liability was accomplished (YYQ):
Cut carefully along dotted line
== . [ scesc accino | oussten eoneoaE | CURRENTFEIN |
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1234 Main Street (oo e 2
2 A TOTAL WAGES PAID THIS QUARTER
Wl Charleston 0200
ﬁ sC 29402-7913 : _?osv\:;Tg_'):)%o\s: 000
o B = = B I
3 A TOTALCONTRIBU =
Q TEM 20 TIkS h 000
5 C T 1 0.00
E r MONTH 1 | MONTH 2 | MONTH 3 1 INTEREST DUE G. GG
b 12/17/08 [~
P p o S 0.00
[ (843) 555-1234 |, 1ess oursranone crenmor
= S A 0.00
7 TOTAL AMOUNT DUE THIS QUA! R
= MAKE REMITTANCE PAYABLE TO: SCESC 0.00

11. Some fields already contain payroll information from your database.

¢ Enter information in all red fields; these are required. You can use the TaB key to quickly move from one

red field to the next.

¢ You can edit blue fields. Once you enter data in a red field, it changes to a blue field.

12. Click Next Step. The Verify Report Complete screen appears reminding you to verify all information
included in report. Click Recheck to return to the report and make any necessary changes or click Agree to

continue.
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13. When you click Agree, the My Copy screen appears displaying a preview of your copy of the report.
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14. Click Print to print a copy for your records. The Print screen appears where you can select the printer, the
number of copies, and adjust the page alignment. Click OK to print. You return to the My Copy screen.

15. Click Next Step. The State Copy screen appears where you can print or eFile the State copy of the report.

¢ Click Print to print the report. The Print screen appears where you can select the printer, the number of
copies, and adjust the page alignment. Click OK to print. When printing finishes, a message appears
asking if you are finished processing the report. Click Yes.

¢ Click eFile to eFile the report. The Aatrix eFile - Login screen appears. For more information about
eFiling a report, see “eFiling Tax Reports” on page 77.

16. When you finish printing or eFiling, the report closes and you return to the New State Tax Reports screen.
Click Save and Close to save the report and return to the State and Federal Tax Reports page.

Federal Tax Reports

You can create federal tax reports for official filing in several formats, depending on the type of report and the
limitations set by federal authorities.

» Creating federal tax reports

Note: The first time you click the State and Federal Tax Reports link in Mail, a message appears asking if you
want to install State and Federal Tax Reports. Click Yes and the program installs automatically.



PAaYrROLL END OF YEAR 75

1. From the Payroll Mail page, click State and Federal Tax Reports or select the State and Federal Tax
Reports tab. The State and Federal Tax Reports page appears.

Fle (dt Vew Go Fgvortes Took Hep
* Dotk # Community Services Inc. - Payn
e S R

SRR ... e
R b

fsme  Desopton | Date Crested  CrestedBy  Others May Modfy | Others May Evecule

]ﬁ‘. Payrol Processng

*2% " .
™ e shrow ry g

Frdnial tax ieporta pintz wage and tax information rehuns including the: 341 quastedy shen aed 345
annual ishan

2. Inthe list on the left, select Federal Tax Reports and click New on the action bar. The New Federal Tax
Reports screen opens on the General tab.

3. Inthe Report name field, select the type of report to create.
The Description box displays the description of the report.

5. In the Reporting period field, select the period to include. Depending on the report, additional fields
appear for you to select the quarter, month, year, or range.

6. Mark Create an output query of employees to create a query of employees included in the report.

A3 New Federal Tax Reports b_<|

File Edit View Favorites Tools Help
Jllal=?-
1: General ]g: Filters]

Select the federal report you want to create

Report Name: 2008 9 edule B/3414 Report

Description: ‘

Reporting Period: |Dne quarker j “ear |Thisyear j Quarter This quarter -

[~ Create an output query of employees

Mest » Cancel Dizplay Report
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Note:

10.

11.

12.
13.

14.

15.

Select the Filters tab.

A3 New Federal Tax Reports @

File Edit View Favorites Tools Help

Filters Indude Selected Filters
Employees All <Al Employees=
Employee Statuses All <All Employee Statuses=
Departments All <All Departments =
Employee Attributes All <All Employee Attributes =

In the filters grid, you can filter the employees or departments to include.

The yellow status bar at the top of the screen displays which copy of the report you are viewing.

. Click Display Report. The federal report opens to the Review/Edit screen.

Some fields already contain payroll information from your database.

¢ Enter information in all red fields; these are required. You can use the TaB key to quickly move from one
red field to the next.

¢ You can edit blue fields. Once you enter data in a red field, it changes to a blue field.

Click Next Step. The Verify Report Complete screen appears reminding you to verify all information
included in report. Click Recheck to return to the report and make any necessary changes or click Agree to
continue.

When you click Agree, the My Copy screen appears displaying a preview of your copy of the report.

Click Print to print a copy for your records. The Print screen appears where you can select the printer, the
number of copies, and adjust the page alignment. Click OK to print. You return to the My Copy screen.

Click Next Step. The Filing Options screen appears where you can print or eFile the Federal copy of the
report.

¢ Click Print to print the report. The Print screen appears where you can select the printer, the number of
copies, and adjust the page alignment. Click OK to print. When printing finishes, a message appears
asking if you are finished processing the report. Click Yes.

¢ Click eFile to eFile the report. The Aatrix eFile - Login screen appears. For more information about
eFiling a report, see “eFiling Tax Reports” on page 77.

When you finish printing or eFiling, the report closes and you return to the New Federal Tax Reports
screen. Click Save and Close to save the report and return to the State and Federal Tax Reports page.

Updating Tax Reports

Warning: If you install Aatrix on Vista with User Account Control (UAC) Admin Approval Mode enabled, the
UAC Elevation Prompt displays. Contact your system administrator for more information about UAC and
entering the necessary credentials.

Each quarter you must run a mandatory update that loads new forms or changes to existing reports. You must be
connected to the Internet to run updates.

» Updating tax reports

1.

From an open state or federal tax report, click Display Report.



3.
4.
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If you are due to update, a message appears asking if you want to update now. Click Yes to run the update
or Exit to run it later. You cannot run reports until you run the update.

If you click Yes, the Aatrix Update Client screen appears while the program downloads to files to update.
When this is complete, the Aatrix Update Client - File Selection screen appears listing all the forms that
are new or have updates.

Select the forms to update and click Next. The update processes.
When the process is complete, click Close.

eFiling Tax Reports

Warning: If you install Aatrix on Vista with User Account Control (UAC) Admin Approval Mode enabled, the
UAC Elevation Prompt displays. Contact your system administrator for more information about UAC and
entering the necessary credentials.

You can eFile your tax reports with the Aatrix eFile service. To eFile your tax reports, you must select an eFile
option on the Processing Options screen of the Filing Wizard.

To eFile, you must be registered for this service. For more information about Aatrix eFile services, see the Aatrix
Web site at www.aatrix.com.

» Enrolling in eFile

When you enroll in the Aatrix eFile program, you can file tax reports electronically to state and federal
agencies. You must be connected to the Internet to enroll in the Aatrix eFile program from State and Federal
Tax Reports.

1.

No v k~uw

From an open state or federal tax report, click the eFile button on the toolbar or select File, eFile from
the menu bar. The Create a Login screen appears.

Enter your user name and password. The accounting package you enter should be the accounting package
you use for your payroll data. Do not list Aatrix unless you are using Aatrix Top Pay for Mac.

Click Next.

Click Next. The Enter Contact Information screen appears.

Enter you contact information. Fields with an asterisk are required.
Click Next. The Enter Taxpayer Information screen appears.

Enter information about the company you are filing for. If you are filing for your own company, mark the
checkbox to use the contact information your entered on the previous screen.

8. Click Next. The Enter Taxpayer Bank Account Information screen appears.

10.
11.
12.
13.

14.

In order for the eFile center to make state or federal payments to agencies, you must enter your bank
account information. If you will not be making payments through the eFile center you can leave the bank
account information dialog blank. If you decide later that you want the eFile center to make payments
you can add the information under the Enrolled Taxpayers tab of the eFile website.

Click Next. The Enter Taxpayer Filing States screen appears.
Select the states you will be filing for and click Next. The Verify Enroliment Information screen appears.
Verify the information is correct and click Save Changes. The Enrollment Accepted screen appears.

You must print the authorization form, sign it and fax it back to the eFile center before you are able to
submit any forms to the eFile center. You can always get a copy of the authorization form under the
Enrolled Taxpayer tab of the eFile website.

Click Print Authorization Form. The Taxpayer Authorization screen appears.



78 CHAPTER

15. You can print and fax this form back to the eFile center. Once the eFile center receives the fax, an email
confirmation will be sent to you. You can then use your new user name and password to log in and
complete the eFile process.

» eFiling a report
You must be connected to the Internet to eFile reports.
1. Once you have completed the Process W-2 Filing wizard, click Submit to access the Filing Options screen.

2. Click eFile to access the Aatrix eFile Center. For more information about the Aatrix eFile Center, see the
Aatrix Web site at www.aatrix.com.

Tax Report History

On the Tax Report History page, you can access saved state or federal tax reports. When you open a saved report,
you can view, edit, or print the static results. “Static” means the report results do not include changes made to
the Payroll database since you last ran the report. To update a report, simply open the saved report parameters
on the State and Federal Tax Reports page, and run the report again.

» Viewing saved reports
1. From the Payroll Mail page, click Tax Report History. The Open Report screen appears.

@ Open Report F$_<|

Select &l Unszelect All

Group Type State | Period Status Date Saved

| [Fededl | 2008004

SUTA sC 2002 Qtr 4 Fecord 12871

Hemave | Close

Wiew/Print ‘ Edit

2. Mark the checkbox for the report you want to open.
3. Click View/Print. The report opens in view-only format. You cannot make changes from this screen.

4. When finished viewing, you can close, print, remove, or eFile the report.
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» Editing saved reports
1. From the Payroll Mail page, click Tax Report History. The Open Report screen appears.

a Open Report El
Select 4l Unselect All
Mame Group Type State | Period Statug Date Saved

[ JFedea [ [o00BGu4 144553

[ 5C UCE-101 Report SUTA 5C 2005 Ot 4 Record 12A7/200814:38:36

Wiew/Print ‘ Edit ‘ Remove | Close

Mark the checkbox for the report you want to edit.

Click Edit. If you are editing a completed report, a message appears notifying you that a copy of the report
is created for editing.

A “completed” report is a report for which you have entered all information on the Review/Edit screen
and clicked Agree on the Verify Report Complete screen. These reports have a checkmark in the
Completed column on the Open Report screen. When you edit a completed report, the edits are made to
a copy of the report. The original remains untouched and you can still access or delete it from the Open
Report screen.

Click OK. The report opens.
5. Make changes as needed and then save and close, print, or eFile.

» Deleting saved reports
1. From the Payroll Mail page, click Tax Report History. The Open Report screen appears.

a Open Report @l
Select &l Unszelect All
Group Type State | Period Status Date Saved
| [Fedeal | 2008 0ud | Reco
SUTA 5C 2005 Ot 4 Record

Wiew/Print ‘ Edit ‘ Hemave | Close

2. Mark the checkboxes for the reports you want to delete.
3. Click Remove. The reports are removed.
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Tax Adjustments

Before generating W-2s, we recommend you reconcile the fourth quarter 941 tax report to ensure error-free
processing. You can use the following table to reconcile form 941 line by line:

ztlml'gg': Report Name Report Options Manual Calculations
Line 1 Payroll Select same months
Register reported on the 941.
Create an output query
and view the number
of employees on
Results tab.
Line 2 Adjusted Gross Grand Total line for See Reference 1
Wage Report  Federal Tax
Line 3 Payroll In Summary by Pay
Register stub ID and include
Taxes on the General
tab. Select Federal tax
on the taxes line of
Filters tab.
Line 5a Adjusted Gross Grand Total line for See Reference 2
Wage Report  Social Security
Line 5¢ Adjusted Gross Grand Total line for Medicare Taxable
Wage Report  Medicare Wages * 2.9%
(Employer + Employee
Percent)
Line 7a Difference between
line 6 and (Social
Security and Medicare
tax withheld from
wages + Employer
Social Security and
Medicare Liability) See
Reference 3
Line 8 Payroll In Summary by Pay Add lines 6 and 7h
Register stub ID for the same
period as the 941
report. (Federal W/H
column + [(Soc Sec +
Medicare columns)
*2])
Line 9 Payroll In Summary by Pay
Register stub ID and include

only Advanced EIC.

Reference 1:

Gross Wages (Payroll Register - include Gross Pay)
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Less:
Wages Not Subject to Federal Tax (Run Payroll Register in detail and look for “N” to Federal Tax)

Pay Types not subject to Line 2 - Include on Line 2 = N (Pay Type Code Table and Payroll Register
specifying those pay types on the Filters tab)

Deductions reducing Line 2 - Reduce for Line 2 = Y (Deduction Code Table  and Payroll Register specifying
those Deductions on the Filters tab)

Run the Payroll Register in detail and scan for each of the above settings. To find the totals, run the Payroll
Register in summary and summarize by Pay stub ID and Quarter.

Reference 2:
Gross Wages (Payroll Register - include all Pay types)
Less:
Wages Not Subject to FICA Tax (Run Payroll Register in detail and look for “N” to FICA Tax)
Pay Types not subject to FICA - FICA = N (Pay Type Code Table and Payroll ~ Register for those other pays)

Deduction reducing FICA - FICA = Y (Deduction Code Table and Payroll Register specifying those
Deductions on the Filters tab)

Wages exceeding the current Social Security limit

Note: The FICA flag setting may have changed during the year. Print the Payroll Register to verify the change
on Pay Types and Deductions from one check to the other. The FICA flag setting is stored with each historical
check.

Run the Payroll Register in detail and scan for each of the above settings. To find the totals, run the Payroll
Register in summary and summarize by Pay stub ID and Quarter.

Social Security Taxable Wages * 12.4% (Employer + Employee%).
Reference 3:

Social Security and Medicare Taxes Withheld from Wages: Run the Payroll Register in summary by Pay stub ID
including Social Security and Medicare withholdings. To include Employer Social Security and Medicare Liability,
mark the checkbox to include Employer Expenses.

If you recently started using Payroll and Line 7a is more than a few cents, you may have omitted the Employer
Expense when entering historical data. Also, this figure can be greater than a few cents if an employee’s FICA flag
was set to Report Only, which updates the Employer Liability Line only.

Frequently Asked Questions

Can | run payroll for the new year before | run W-2s?
Yes. Payroll looks at historical data for only the W-2 calendar year to process forms.

xR

What happens if | calculate for the new year without adding or updating any tax tables?

A: If you do not update the tax information, your W-2s may not be accurate for the upcoming year and you will
have to make payroll adjustments to correct this information. Also, your 941 tax report, state tax report, and local
tax reports may be incorrect. In some cases, you will not be able to make adjustments to correct these reports. It
is crucial that you make the necessary changes to your tax tables prior to running the first payroll of the new year.

Q: Are default tax table changes automatically loaded after installing the end-of-year update?

A: No, the updated tax table information is not automatically loaded into your tax tables. To take advantage of
updated defaults, you must create a new tax table for the upcoming tax year and then restore table defaults. To
do this, access the Tax Tables tab in Configuration and create a new state or federal tax table. To load the
updated defaults, access the Federal or State menu and select Restore Defaults.

Q: If thereis not a hard close in Payroll, how does the program know we are entering a new year?
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A: Most reports within Payroll are based upon check dates or period ending dates, which you specify when
running the reports. W-2s are run based on a calendar year. All check information that falls within the calendar
year that you specify will be reflected in the appropriate boxes on the W-2.

Q: Where do | alter box 14 and 15 information for each employee’s W-2?

A: This information is defined on the Tax Settings tab of the employee record. On the Taxes tab, you will see a
W-2 option. This is where both box 14 and box 15 information is defined. Deductions, Pay Types, and Local
Employer Only tax can all print in Box 14 (maximum of three per employee).

Q: An employee left the organization, so | entered a termination date and reason. When | calculate for the new
year, the employee is still included. Why?

A: When creating payroll calculations, you can choose to calculate for all statuses or selected statuses. You may
want to deselect employees with a terminated status.

Additional End-of-Year Resources

Have additional questions about the end-of-year process? Check out these resources:

e W-2 Wizard, an interactive wizard that takes you step-by-step through the process of making adjustments and
correcting information.

The W-2 Wizard is not compatible with Internet Explorer. To access the wizard, you must use Chrome or Firefox
as your web browser.

¢ Knowledgebase to find answers to how-to questions and troubleshoot software issues.

e Forums to discuss best practices with your peers and review shared Client Documents.
¢ Blackbaud Forms to order W-2 and other tax forms.



https://www.blackbaud.com/blackbaud-forms
http://forums.blackbaud.com/forums/66.aspx
http://www.blackbaud.com/kb/index?page=home
http://www.blackbaud.com/support/faqs/w2.aspx
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